FOILFAST® PRINTER

MODEL 21 USER’S MANUAL




IMPORTANT - READ THISAGREEMENT CAREFULLY BEFORE INSTALLING THE FOILFAST PRINTER DRIVER SOFTWARE ON YOUR
COMPUTER. By installing the software, you indicate your acceptance of the following Powis Parker Inc. License Agreement (“ Agreement”). If you do
not agree with the terms of this agreement, do not install the software on your computer.

POWISPARKER INC.
LICENSE AGREEMENT AND WARRANTY FOR THE FOILFAST™ PRINTER

This Agreement is a legal agreement between you (either an individual or a single entity) and POWIS PARKER INC. (“Powis Parker”) regarding the use
of the Foilfast™ printer, which includes computer software and associated printed materials. By installing or copying the computer software, you are
agreeing to be bound by the terms of this Agreement. If you do not agree to be bound by the terms of this Agreement, please do not install the software.
If you do not agree to be bound by the terms of this Agreement, you are not authorized to use the PRINTER or any portion thereof, including the
SOFTWARE. Any unauthorized use is a violation of the law and acts as a total nullification of all warranties.

1. COPYRIGHT. The SOFTWARE is protected by United States copyright laws and international copyright treaty provisions, as well as other
intellectual property laws and treaties. The SOFTWARE is licensed pursuant to the terms and conditions of this Agreement and is not sold. You may
not copy the printed materials accompanying the PRINTER or SOFTWARE except as specifically permitted herein.

2. GRANT OF SOFTWARE LICENSE. Subject to the terms and conditions of this Agreement, Powis Parker hereby grants to you a non-exclusive, non-
transferable (except as expressly permitted herein), non-assignable license (without right to sublicense) to use the SOFTWARE on any computer
with an attached PRINTER. For purposes of this Agreement, the SOFTWARE shall be deemed in “use” on a computer when it is loaded into
temporary memory (i.e. RAM) or installed into permanent memory (e.g., hard disk, CD-ROM, or other storage device) of that computer. You may
make one (1) copy of the SOFTWARE for backup or archival purposes only.

3. RESTRICTIONS. You may not rent or lease the SOFTWARE, but you may transfer the SOFTWARE and accompanying materials on a permanent
basis to a recipient acquiring the PRINTER, provided that you retain no copies and the recipient agrees to be bound by the terms of this Agreement.
You may not reverse engineer, decompile, disassemble or otherwise attempt to derive source code from the SOFTWARE. If the SOFTWARE is an
update or has been updated, any transfer must include the most recent update and all prior versions. You may not distribute copies of the
SOFTWARE to third parties. You may not copy, transfer or grant any rights in or to all or any portion of the SOFTWARE, except as expressly
provided herein. You must comply with all applicable laws regarding the use of the SOFTWARE. You may not modify or prepare derivative works
of the SOFTWARE. You may not transmit the SOFTWARE over a network, by telephone, or electronically by any means.

4. RIGHTS IN SOFTWARE. All rights and title in and to the SOFTWARE and any copies thereof are owned by Powis Parker or its suppliers. This
Agreement is not a sale and does not transfer to you any title or ownership interest in or to the SOFTWARE or any patent, copyright, trade secret,
trade name, trademark or other intellectual property right therein. You shall not remove, alter, or obscure any proprietary notices contained on or
within the SOFTWARE and shall reproduce such notices on any back-up copy of the SOFTWARE. All title and intellectual property rights in and
to the content that may be accessed through use of the SOFTWARE is the property of the respective content owner and may be protected by
applicable copyright or other intellectual property laws and treaties. This Agreement grants you no rights to use such content.

5. LIMITED WARRANTY. Powis Parker warrants that

(i) the PRINTER will be free from defects in materials and workmanship, assuming normal use, for a period of twelve (12) months from the date of
purchase; and

(ii) the SOFTWARE will perform substantially in accordance with the accompanying written materials for a period of ninety (90) days from the date of
receipt. Powis Parker does not warrant the operation of PRINTER or the SOFTWARE to be uninterrupted or error-free. The limited warranty set forth in
this Section 5 covers only those defects which arise as a result of normal use of the PRINTER, and shall not apply in the event of any:

a) improper or inadequate maintenance;

b) unauthorized modifications or misuse;

c) damage due to accident, abuse or negligence;

d) operation of the PRINTER beyond the designated duty cycle;

e) operation outside of the environmental specifications for PRINTER;

f) operation of the PRINTER with a mechanical switchbox without the use of designated surge protector;

g) customer supplied software or interfacing;

h) operation of non-supported printing media;

i) use of other than POWIS PARKER specified foil cartridges;

j) improper site preparation and maintenance.
6. CUSTOMER REMEDIES.

a. If the Software proves defective during the applicable warranty period, you may return the defective disk to your local Powis Parker
products (Fastback®) dealer representative, along with a dated proof of purchase; the dealer representative will replace it free of charge. If the Software

proves defective after the applicable warranty period has expired, you may obtain a replacement disk by sending the defective disk and a check for the
purchase price to your local Fastback® dealer.



b. If the PRINTER proves defective during the applicable warranty period, the dealer shall, at its option, either:

(i) repair the PRINTER;

(ii) replace the PRINTER with one that is new or like-new, provided that the replacement has equivalent or better functionality than the one it
replaces; or

(iii) if the Fastback® dealer is unable to repair or replace a defective PRINTER covered by warranty, the dealer shall, within a reasonable
time after notification of defect, refund the purchase price for the PRINTER, provided that you return the defective PRINTER along with proof of
purchase.

7. NO OTHER WARRANTIES. EXCEPT FOR THE LIMITED WARRANTY SET FORTH IN SECTION 5 ABOVE, THE PRINTER AND
SOFTWARE ARE PROVIDED “AS-IS”, AND POWIS PARKER GRANTS NO OTHER WARRANTIES, EXPRESS, IMPLIED, STATUTORY OR
OTHERWISE, REGARDING THE PRINTER, SOFTWARE OR RELATED MATERIALS, THEIR FITNESS FOR PARTICULAR PURPOSE,
THEIR QUALITY, THEIR MERCHANTABILITY, OR OTHERWISE.

8. LIMITATION OF LIABILITY: TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL POWIS PARKER
OR ITS SUPPLIERS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES WHATSOEVER
(INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, INTERRUPTION, LOSS OF BUSINESS
INFORMATION, OR ANY OTHER PECUNIARY LOSS) ARISING OUT OF THE USE OF OR INABILITY TO USE THE PRINTER OR THE
SOFTWARE, EVEN IF POWIS PARKER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME STATES
AND JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL
DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY.

9. U.S. GOVERNMENT RESTRICTED RIGHTS. The SOFTWARE is provided with restricted rights. Use, duplication, or disclosure by the United
States Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at
DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer Software Restricted Rights at 48 CFR 52.227-19, as
applicable.

10. MISCELLEANEOUS. This Agreement is governed by the laws of the United States and of the State of California without reference to conflicts of
laws principles. You shall not assign, sublicense or otherwise transfer the rights or license granted hereunder, by agreement or by operation of law,
without the prior written consent of Powis Parker, and all assignments in violation of this prohibition shall be null and void. This Agreement is the
complete and exclusive agreement of Powis Parker and you and supersedes all other communications, oral or written, relating to the subject matter
hereof. No change to this Agreement shall be valid unless in writing and signed by the party against whom enforcement is sought. The waiver or
failure of Powis Parker or you to exercise in any respect any right or rights provided for herein shall not be deemed a waiver of any further right
hereunder. If any provision of this Agreement is held unenforceable, the remainder of this Agreement will continue in full force and effect.

11. POWIS PARKER PRODUCT SUPPORT. To obtain limited warranty service or product support, you should first contact your local Fastback®
(Powis Parker products) dealer. To locate the Fastback® dealer nearest you, you may call Powis Parker at 1-800-321-BIND or (510) 848-2463
between the hours of 8:00 AM and 5:00 PM Pacific time, Monday through Friday.

Should you have any other questions concerning this Agreement, or if you desire to contact Powis Parker for any reason, please write: Powis Parker Inc.
775 Heinz Avenue Berkeley, CA 94710 or email: powis @powis.com.

Copyrighto 1999 by Powis Parker Inc.

This guide may not be copied wholly or in part without prior written permission from Powis Parker Inc.

Regardless of the contents of this guide, Powis Parker Inc. will not bear the responsibility for negative effects incurred as a result of the operation of this
equipment.

The contents of this guide are subject to change without prior notification.

Great care has been taken in the preparation of this guide. However, if you should discover an error or an omission, please bring it to our attention.
PS/2 and AT are registered trademarks of International Business Machines Corporation. MS-DOS, Microsoft, Windows 95, Windows 98, and the
Windows logo are registered trademarks of Microsoft Corporation. Apple, Macintosh, iMac, iBook, QuickDraw GX, Performa, At Ease, Disk First Aid,
Queue Kit, Queue Monitor, and Queue Watcher are registered trademarks of Apple Computer. Other brand or product names are trademarks or registered
trademarks of their respective holders.

As an ENERGY STAR® Partner, Powis Parker Inc. has determined that this product meets the ENERGY STAR guidelines for energy efficiency.

POWIS PARKER INC.
775 Heinz Avenue
Berkeley, CA 94710

Telephone: (800) 321-2463, or (510) 848-2463
FAX: (510) 848-2462
WWW.powis.com

Printed in USA



RADIO & TELEVISION INTERFERENCE

UNITED STATES. The equipment described in this guide generates and uses radio frequency
energy. If it is not installed and used in accordance with the instructions in this guide, it may
cause interference with radio and television reception.

This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference in a residential installation. This equipment generates,
uses and can radiate radio frequency energy and, if not installed and used in accordance with
the instructions, may cause harmful interference to radio communications. However, there is
no guarantee that interference will not occur in a particular installation. If this equipment
does cause harmful interference to radio or television reception, which can be determined by
turning the equipment off and on, the user is encouraged to try to correct the interference by
one or more of the following measures:

» Reorient or relocate the receiving antenna.
* Increase the separation between the equipment and receiver.

* Connect the equipment into an outlet on a circuit different from that to which the receiver
is connected.

* Consult the dealer or an experienced radio/TV technician for help.
If necessary, you should consult your dealer or experienced radio/television technician for

additional suggestions. You may find helpful the following booklet, prepared by the Federal
Communications Commission: How to Identify and Resolve Radio-TV Interference Problems.

This booklet is available from the United States Government Printing Office, Washington,
D.C. 20402. The booklet number is 004-000-00345-4.

Note: Changes or Modifications not expressly approved by the party responsible for compliance
could void the user’s right to operate this equipment.

Peripherals used in conjunction with this equipment must be connected via shielded interface
cables. Use of unshielded interface cables may result in interference to radio and TV reception,
and may void the user’s right to operate this equipment.

Declaration of Conformity

Model Number: P21

Trade Name: Foilfast™ Printer

Responsible party: Powis Parker Inc.

Address: 775 Heinz Avenue Berkeley, CA 94710 USA

Telephone number: (800) 321-2463

This device complies with Part 15 of the FCC Rules. Operation is subject to the follow-
ing two conditions: (1) This device may not cause harmful interference, and (2) this
device must accept any interference received, including interference that may cause
undesired operation.




IMPORTANT SAFETY INSTRUCTIONS

10.

11.

12.

Read all of these instructions and save them for future reference.
Follow all warnings and instructions marked on the product.

Unplug this product from its power source before cleaning. Do not use liquid or aerosol
cleaners. Use a damp cloth for cleaning.

Do not use this product near water.

Do not place this product on an unstable cart, stand or table. The product may fall, causing
serious damage to the product.

Slots and openings on the cabinet are provided for ventilation. To ensure reliable operation
of the product and to protect it from overheating, do not block or cover these openings.
The openings should never be blocked by placing the product on a bed, sofa, rug or other
cushioned surfaces. This product should never be placed near or over a radiator or heat
register. This product should not be placed in a built-in installation unless proper ventilation
is provided.

This product should be operated from the type of power source indicated on the marking
label of the AC adaptor. If you are not sure of the type of power available, consult your
dealer or local power company.

Do not allow anything to rest on the power cord. Do not locate this product where the cord
will be walked on.

If an extension cord is used with this product, make sure that the total of the ampere
ratings on the products plugged into the extension cord do not exceed the extension cord
ampere rating. Also, make sure that the total of all products plugged into the wall outlet
does not exceed 15 amperes.

Never push objects of any kind into this product through cabinet slots as they may touch
dangerous voltage points or short out parts that could result in a risk of fire or electric
shock. Never spill liquid of any kind on the product.

Except as explained elsewhere in this guide, do not attempt to service this product yourself.
Opening and removing those covers that are marked “Do Not Remove” may expose you
to dangerous voltage points or other risks. Refer all servicing on those compartments to
service personnel.

Unplug this product from its power source and refer servicing to qualified service personnel
under the following conditions:

A. When the power cord or plug is damaged or frayed.
B. If liquid has been spilled into the product.

C. If the product has been exposed to rain or water.

D

. If the product does not operate normally when the operating instructions are followed.
Adjust only those controls that are mentioned in the operating instructions, since
improper adjustment of other controls may result in damage and will often require
extensive work by a qualified technician to restore the product to normal operation.

tm

If the product has been dropped or the cabinet has been damaged.

F. If the product exhibits a distinct change in performance, indicating a need for service.
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Thank You !

And congratulations!

You have purchased a revolutionary product. Our Foilfast™ printer allows you to do
what only professional foil stampers have been able to do, until now: print customized
text and designs in brilliant foil colors, with excellent clarity, on a variety of cover
materials. All in less than a minute.

Now you can design and print your own document covers right on your desktop, in
real time—for just a few cents per print. Personalize individual copies of a report, add
your company logo, include your client’'s name on your next proposal: the possibilities
are endless.

Connect the Foilfast printer to your Mac or PC, create a design using your favorite
software application, choose your colors and print. It's that easy. Whether you choose
our popular Foilfast composition covers or our ClearCovers™, the Foilfast prints crisp,
bright images and text with excellent clarity. We’ve even included a feature allowing
you to print your design’s mirror image, so you can print on the inside of your document’s
ClearCover, creating a striking, professional look.

The Foilfast printer is only one of our revolutionary document finishing products, and
we hope you ask your Fastback® dealer about Fastback document binders and the
PowisPrinter™. And we invite you to visit us on the web at www.powis.com.

If you have any comments, please contact the Fastback dealer from whom you pur-
chased the Foilfast printer. To locate your local Fastback dealer, call us at 1-800-321-
BIND.

We thank you very much for your purchase. And we hope you enjoy using your Foilfast
printer.

Sincerely,

Powis Parker Inc.




Service, Support and Supplies

For US Customers

We hope you enjoy your Foilfast™ printer, and we want to make your Foilfast
ownership a satisfying experience. If at any time, you would like technical assis-
tance, service or supplies, your Fastback® dealer is available to help you. To
locate your Fastback dealer, call Powis Parker customer service at 1-800-321-
BIND.

Service

If the software disc proves defective during the applicable warranty period, you
may return the defective disc to your local Fastback dealer, along with a dated
proof of purchase; the dealer representative will replace it free of charge.

If the printer proves defective during the applicable warranty period, your Fast-
back dealer will either:

(i) repair the printer;
(i) replace the printer with one that is new or like-new, provided that the
replacement has equivalent or better functionality than the one it replaces; or

(iii) if the Fastback dealer is unable to repair or replace a defective printer
covered by warranty, the dealer will, within a reasonable time after notification
of defect, refund the purchase price for the printer, provided that you return
the defective printer along with proof of purchase.




The label for this product can be found in the location shown below:

Location of Label




Chapter 1

Major Functions and
Operations

Learn the Major Functions and
Operations of Your Foilfast Printer

This chapter describes how to set up your printer, the
name of each part of your printer and how it functions,
how to insert the cartridges and cover sheets, and how
to install the printer driver software. Read this chapter

before you use the printer for the first time.



Chapter 1 - Major Functions and Operations

Getting Your Folilfast Printer Ready

Set up your Foilfast printer by performing the following steps:

» Get your printer ready.
Remove the packing materials.

» Connecting cables.
Connect the printer to your computer with a printer cable and to a suitable AC
power source with the power cord.

Getting Your Printer Ready

Get your printer ready by removing the packing materials from inside and outside
the printer.

Caution

This printer is shipped with tape, spacers, and other packing
materials to prevent delicate parts from being damaged while in
transit. Remove these packing materials before using the printer.
If the printer is used while these packing materials are still
present, damage to the printer or malfunction may occur.

B Removing the outside packing materials
The printer is shipped with packing materials to prevent damage during transit.
Please remove the tape (three locations) from the printer cover before going to
the next step. (See illustration for locations.)

Remove the tape

[

B Opening the front cover
Open the front cover to remove the inside packing material. To open the front
cover, push the front cover release button. Gently lower the front cover with your
hand. Do not let it drop without support.

10



WINDOWS & MACINTOSH — Getting Your Printer Ready

Front cover
release button

N Front cover
Make sure nothing is

under the cover.

B Removing the carriage packing material
There are three (3) items to be removed from the inside of the printer.
1.Remove the cardboard carriage packing material that is to the left of the car-
riage.
2.Press down on the blue paper release lever found to the right of the carriage.
Remove the tape from the metal frame that holds the small white foam car-
riage packing material in place and remove the foam piece.

Release lever

Carriage packing material

3.Remove the tape located on the left side of the carriage by gently grasping the
tape and pulling slightly toward the left and forward at the same time. You need
to remove the tape in one piece.

tape

11



Chapter 1 - Major Functions and Operations

Caution

Do not remove the white pad or the cleaning pad at the left end
of the platen. They are there to clean the print head. Removing
them can cause the printer to malfunction. The cleaning pad
can be replaced when it gets dirty. Do not touch the cover-open
sensor, which is located inside the printer on the left end.

Cleaning pad

Cover open sensor

B Closing the front cover
Close the front cover after removing the carriage packing material.

Caution

When closing the front cover, never slam it shut. The ink car-
tridges can become dislodged and damage to the printer may
result.

rx/\@, *

A<

*
—

Situating the Printer

After removing the packing material from the outside and inside of the printer
and reading the section “IMPORTANT SAFETY INSTRUCTIONS” (located on
page 2), position the printer in an appropriate location. Ensure there is enough
space to use your printer easily.

Installing the Output Tray

Place the printer on the output
tray as shown in the picture.
During printing, gently pull the
output tray all the way out.

Make sure nothing is on
the output tray.

12



WINDOWS & MACINTOSH — Getting Your Printer Ready

Using the Dust Cover

Use the dust cover when the printer is idle and when using Composition Covers.

B How to assemble the Dust Cover
Assemble the dust cover as shown below.

Bend the incised part
inside as shown in the
figure

Bend the incised part
inside as shown in the

This part of the dust cover
must be in contact with the
printer case.

B How to place the Dust Cover
Use the dust cover, as dust may cause a malfunction.

Slide the dust cover into place.

Dust Cover

13



Chapter 1 - Major Functions and Operations

Connecting Cables for Windows

When your printer is properly set up, connect the printer to your computer with a
printer cable and to a suitable AC power source with the power cord.

e Connect the printer to your computer.
» Connect a power cord to the printer.

BN Connecting the printer to your computer

1. Make sure that the power to your computer is completely
turned off. If the computer is running, quit all running ap-
plications, shut down the system, and turn off the power.

Caution

Both printer and computer must be unplugged before connect-
ing or disconnecting the printer cable. Otherwise, damage or
malfunction may result.

2. Connect the printer to the computer with a standard par-
allel or bidirectional printer cable. Secure the printer cable
to the connectors on the printer and on the computer.

Accessory connector for
Macintosh interface module

Printer connector

Bi-directional printer cable

D/ Note
When using your printer with a Macintosh computer, connect

the printer to the computer using a Macintosh interface module.

14



WINDOWS — Getting Your Printer Ready

B Power cord connections

1. Plug the power cord into the power cord socket on the
printer. Make sure the power cord is securely seated in
the socket.

2. Plug the free end of the power cord into a suitable AC
power source (such as a wall socket or power strip).

Power cord socket

Power cord

Caution

Power to the printer is completely cut off only when the cord is
unplugged. Place the printer where you can easily unplug it
from the power source. Also, pull the plug and not the cord
when unplugging the printer.

15



Chapter 1 - Major Functions and Operations

Connecting SCSI Cables for Macintosh

When your printer is properly set up, connect the printer to your Macintosh with a
SCSiI cable, and to a suitable AC power source with the power cord.

e Connect the printer to your computer.
e Connect a power cord to the printer.

B How to attach the Macintosh interface module
When using your printer with a Macintosh computer, connect the printer to the
computer using a Macintosh interface module as shown in the pictures below.

1) Turn off the power to your printer, computer, and all SCSI devices connected.
Unplug the power cord from the power source and the printer.

2) Remove the rectangular plastic connector cover located to the right of the
printer port. Grab the tab at the bottom of the connector cover, pull it up, and
twist it until the cover breaks away.

3) Angle the Macintosh interface module so that the tab on top of the module
slips under the top edge of the PC printer cable slot. The top edge of the
module should rest against the frame of the printer.

4) Gently press the bottom of the module until it clicks into place.

Al

G}
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Macintosh interface module

Caution

When you connect the Macintosh interface module, make sure
that the printer power has been turned off. Never plug in the
power cord before connecting the module. Doing so can cause
the printer to malfunction.

16



MACINTOSH — Getting Your Printer Ready

B How to remove the Macintosh interface module
1) Turn off the power to your printer, computer, and all SCSI devices connected.
Unplug the power cord from the power source and the printer.

2) Remove the Macintosh interface module by gently pulling the plastic handle
at the bottom of the module as shown in the picture and lifting the module
away from the printer.

I Connecting the printer to your computer

1. Make sure that the power to your computer is completely
turned off. If the computer is running, quit all running ap-
plications, shut down the system, and turn off the power.

Caution

* Both printer and computer must be unplugged before con-
necting or disconnecting the printer cable. Otherwise, dam-
age or malfunction may result.

* Use a high-impedance SCSI cable and an active terminator
for best results.

* Using other types of cables can cause the printer to malfunc-
tion.

2. Connect the printer to the computer with a SCSI cable.
Secure the printer cable to the connectors on the printer
and on the computer.

Also, you must attach a terminator to the printer if the printer is
the last peripheral on the SCSI chain.

DIP switches

SCSl interface
connector

SCSI cable
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Check the SCSI device number

Make sure the device number for the printer is set correctly.
Each SCSI device connected to the computer must have a
unique SCSI device number. If two devices have the same
device number, they will not work properly. (The printer device
number is set to 6 at the factory. To change the device num-
ber, use the DIP switches next to the connector. For more
details, refer to “Specifications” in the appendix.)

B Power cord connections

1. Plug the power cord into the power cord socket on the
printer. Make sure that the power cord is securely seated
in the socket.

2. Plug the free end of the power cord into a suitable AC
power source (such as a wall socket or power strip).

Power
source

Power cord socket

Power cord

Caution

Power to the printer is completely cut off only when the cord is
unplugged. Place the printer where you can easily unplug it
from the power source. Also, pull the plug and not the cord
when unplugging the printer.
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Connecting USB Interface Cables for Macintosh

When your printer is properly set up, connect it to your computer with a universal

serial bus (USB) interface cable, and to a suitable AC power source with the
power cord. The iMac @, the iBook® and the PowerMac ® G4 all support the USB
interface.

» Connect the printer to your computer.
» Connect a power cord to the printer.

B Connecting the printer to your computer

1. Make sure the power to your computer is completely
turned off. If the computer is running, quit all applications,
shut down the system, and turn off the power.

Caution

Both printer and computer must be unplugged before connect-
ing or disconnecting the printer cable. Otherwise, damage or
malfunction may result.

2.  Connect the printer to the computer with a USB interface
cable.

Printer connector

(to the computer)

USB interface cable

3. Connectthefree end of the USB cable to an available USB
port or USB hub.

a  Toconnectthe USB cable directly to your Macintosh, locate
the USB port, hold the connector on the USB cable with the
three-pronged USB icon facing up, and then plug the cable
into the USB port.

b  Toconnectthe USB cable to a USB hub, orient the connector
on the USB cable to match the connector on the USB hub,
and then plug the cable into the hub. Connect the USB hub to
your Macintosh.

19



Chapter 1 - Major Functions and Operations

Caution

Do not plug the USB cable directly into the iMac keyboard. The
USB port on the keyboard does not supply its own power, so the
combined current drain of the printer and the keyboard might
exceed USB specifications.

(to keyboard)

USB interface cable

(to printer)

USB interface cab&

(to printer)

B Power cord connections

1. Plug the power cord into the power cord socket on the
printer. Make sure that the power cord is securely seated
in the socket.

2. Plug the free end of the power cord into a suitable AC
power source (such as a wall socket or power strip).

Power
source

Power cord socket

Caution

Power to the printer is completely cut off only when the cord is
unplugged. Place the printer where you can easily unplug it
from the power source. Also, pull the plug and not the cord
when unplugging the printer.
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Name and Function of Each Part of the Printer

This section explains the name and function of each printer part.

Foilfast Printer (front view)

Sheet feeder
Place a stack of 10 Foilfast Composition Cov-
ersor 1 Failfast ClearCover into the sheet feeder.

Front cover release button

Opens the front cover. Open the front cover when
there is a sheet jam or when changing cartridges.
Open the front cover gently, using both hands.

Front cover
This cover protects the printer's internal mecha-
nism. The cover must be closed during printing.

Output slot
Sheets exit the printer through this slot.

Caution
« Neverreachinto the printer while itis operating. Injury may
result.
« Do not open the front cover while the printer is running.

*«  When the front cover is opened for any reason, remove the
cartridge and take up any slack in the ribbon, then
return the cartridge.

Stopper
This stopper prevents cover sheets from rising.

Support
This support holds the loaded sheets upright.
To extend the support, pull up on the top edge.

Feed guide
This guide feeds the sheets into the printer.
Set the guide to match the size being used.

Caution

Never reach into the sheet feeder. By doing so, you might get
injured, or the printer might malfunction.
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Foilfast Printer (rear view)

Accessory connector

This connector is for the Macintosh interface
module. Make sure you remove the rectangu-
lar plastic connector cover before connecting
the interface module.

Parallel interface connector
The printer cable plugs into the parallel inter-
face connector.

Power cord socket
The power cord plugs into this socket.

Foilfast Printer (rear view with Macintosh interface module)

DIP switches
The DIP switches set the SCSI device number
forthe printer.

SCSI connector
The SCSI connectors connect the computer
to SCSI devices.

Power cord socket
The power cord plugs into the power cord socket.
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Inside the Printer

Marking sticker

This allows you to confirm that the carriage is in the
standard position. Try not to smear the face of the
sticker. Ifit gets dirty, gently clean it with a dry cotton
swab. As you do so, be careful not to peel it off.

Cartridge holder plate

Three out of four of the holder plates can hold two car-
tridges each. The fourth plate can hold only one. You can
load up to seven cartridges at a time.

Carriage

The carriage automatically picks up the specific cartridge
needed for printing and moves it to the printing location.
The carriage also contains the print head.

Release lever

This lever, located to the right of the carriage and platen,
is used to clear sheet jams. Press the release lever down
to remove the jammed sheet. When you close the front
cover, the lever will automatically go back o its original

position.

Print head
The print head prints the characters. Do not touch it.

Caution

Do not touch the print head or the carriage. Doing so can cause damage to the printer.
Also, never load a cartridge directly into the carriage. Malfunction or damage to the
printer may result.
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Control Panel

The top of the printer has two buttons and three LED indicator lights. By pushing
one of these buttons and looking at the lights, you can perform various printer
functions, such as ejecting a sheet.

power button
Use the power button to turn the printer on and off.

ready/insert button
Use the ready/insertbutton to load and eject sheets.
power ready / insert When a sheet is not fed ( errorlight is blinking), press

the ready/insertbutton .

l o o Press the button for three seconds or more to printa

(") poner Oreaty  \ eror sample page. You can print a sample page even when
the printer is not connected to a computer.
error light

This light blinks when an error occurs.

ready light

When the lightis lit, the printer is ready to print. The
light blinks slowly while printing. When itis not it,
printing is paused.

power light

Indicates whether the printer is on or off.

When the light is on, the printer is on. When the light is
off, the internal parts of the printer still have power. To
completely shut off power to the printer, unplug the power
cord from the socket.
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Installing Cartridges

This section describes how to identify cartridge types and how to install and exchange
cartridges.

Identifying Foil Cartridge and Cover Types
The cartridge type is indicated on the surface of each cartridge.

The product name appears in this area.

Premium Foil Cartridges

Premium Gold Foil cartridge
Premium Silver Foil cartridge
Premium Red Foil cartridge
Premium Blue Foil cartridge
Premium Green Foil cartridge
Premium Black cartridge
Premium White cartridge
Primer cartridge (“Undercoat”)

Cover Types

Foilfast Composition Cover
Foilfast Coated Paper Cover
Foilfast ClearCover

Caution

Remove each printed ClearCover from the output tray before the
next printed ClearCover is ejected from the printer. If the printed
ClearCovers are left in a pile for a long time, they may stick
together.
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Installing Cartridges

Install cartridges by following the steps below.

E:I/ Note
The carriage can select and pick up the necessary color car-

tridge from any holder. You can put up to 7 cartridges of the
same color in the holders to reduce the need to change car-
tridges, or you may load different color cartridges.

Caution

The cartridges may be put in any holder but DO NOT put car-
tridges directly into the carriage. Doing so may result in dam-
age the printer.

You must leave at least one cartridge holder empty for the printer
to operate properly. Do not install more than 7 cartridges.

1. Remove the stopper from the cartridge.

First, remove the stopper from the cartridge. The stopper pre-
vents slack in the foil during shipment or storage.

Stopper

2. Take up any slack in the foil.

Insert a pencil into the side marked “B”. Turn the pencil slowly
to take up any slack in the foil.

Foil Cartridge

3.  Open the front cover of the printer.

Push the front cover release button to release the interal lock.
Gently lower the front cover with your hand.

26



WINDOWS & MACINTOSH — Installing Ink Cartridges

4. Insert the cartridges.

* Hold the cartridge so that the side with
the letter “B” faces upward, and the “B’is
on the upper right of the cartridge. Hold
the center of the cartridge with your thumb
and index finger.

* Insert the left end of the cartridge, while pushing the left
side latch of the cartridge holder slightly to the left with the
cartridge.

Make sure that the cartridge is securely locked into the
holder, and that there is no slack in the foil.

» Put the second cartridge on top of the cartridge already
installed. Gently push down the center of the cartridge.

Caution

Place the side marked “B” face up. If the cartridge is installed
upside down, the printer will not know it has been installed.
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Exchanging Cartridges

You can change or replace empty cartridges by following the steps below.

E:I/ Note
When a cartridge has been used up, black and silver stripes will

bevisible on the foil.

black and silver stripes

1. Open the front cover of the printer.
Open the front cover by pushing the front cover release button.

2. Remove the cartridge
* Removing a cartridge is similar to installing it. Hold the cen-
ter of the cartridge with your thumb and index finger. Push
the left latch on the cartridge holder slightly to the left with
the cartridge.

* Lift up the right side of the cartridge, and then remove the
entire cartridge.

Caution

Take up any slack in the foil before installing cartridges.

3. Install a new cartridge on the cartridge holder plate.

Insert a cartridge by following the steps described in the previ-
ous section titled “Installing Cartridges.”
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Loading Sheets

Loading Sheets

You may load up to 10 composition covers at a time, and successive sheets will
automatically feed. When printing on ClearCovers, you must load each sheet
into the feeder, one at a time. If you load multiple ClearCovers, they will stick
together and cause a jam in the feeding mechanism.

1. Pull up the support.
Support

2. Place the sheets in the feeder.

D/ Note
« Using a creased or curled sheet can cause the sheet to

misfeed.

« Fan the stack of sheets once before placing it in the feeder.
The printer may feed two sheets together if the sheets are
stuck together.

« Use only one type of sheet at a time.

¢ Place a stack of not more than 10 composition covers or 1
ClearCover into the feeder.

A Caution
Composition covers should be between 16 —-18.5 points thick

(.0016 — .00185 inches). Clear covers should be between 6.5 -7.5
points thick (.0065 — .0075 inches). Covers that fall outside the
bounds of these thickness ranges may work in the Foilfast printer,
but Powis Parker does not recommend using them. Covers that
fall substantially beyond these thickness ranges may damage
the printer's feeding mechanism and may void your warranty.
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3.

Adjust the feed guide to the proper size.

Leave about 0.02” between the edge of the sheet(s) and the
feed guide. The stopper will prevent the sheets from rising.

Stopper

Feed guide

D/ Note
« If the space is too wide, sheets may feed diagonally.

* If the space is too narrow, sheets may not feed.
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Installing the Printer Driver for Windows

Before you can use your printer, you need to install the printer driver software so that
your computer can work with the printer.

This section describes how to install the printer driver.

Purpose of the Printer Driver

The printer driver software helps to control the printing process, so the printer
driver you select must match the printer you're using. To take full advantage of
the many features of the Foilfast printer, always create your documents after you
have selected the Foilfast printer driver. If you have a different printer driver se-
lected when you print your document, only the print settings that match the func-
tions of your Foilfast printer will be valid.

System Requirements

The system requirements for the printer driver software are as follows:
Computer: IBMPC-AT or compatible

Os: Microsoft Windows 95/98 ©
Total RAM: 16 MB or more (32 MB or more is recommended)

Disk space required during printing (approximate):
Single color, 10 MB
Multiple colors, 40 MB

D/ Note
The working disk space needed during printing is automatically

erased after printing is completed.

Installing the Printer Driver

Insert the disc into the CD-ROM drive. The contents of the disc will automatically
display. Double-click the “Setup” icon, to begin installation, or read the “Readme”
file for detailed instructions. After connecting the printer cable to your PC, restart
your computer.
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Turning the Power On or Off

Turn your printer and computer on or off by following the steps described below.

Turning on the Power

Turn on the power by performing the following steps.

1. Push the power button on the printer to turn it on.

2. Turn on your computer.

Turning off the Power

When you finished printing, turn off your printing devices by performing the fol-
lowing steps.

1. QuitWindows, and then turn off your computer.

2. Push the power button on the printer to turn it off.
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Printing Operations

Print Mode

Foilfast premium foil cartridges come in a range of colors. You may load several
colors into the Foilfast printer at the same time, or you may load just a single
color.

« Single Ink (one foil color)
This print mode allows you to print a document in monochrome using one
cartridge. All selectable cartridges are shown with radio buttons in the Select
Cartridge(s) area in Print/properties. Click the radio button next to the color
you wish to use. The default selection is Gold Foil.

e Multiple Inks (2 or more colors)
This print mode allows you to print a document in multiple colors. Select Mul-
tiple Inks in the Select Cartridge(s) area in Print/properties. All selectable car-
tridges are shown with checkboxes. You must select at least 1 and no more
than 7 colors. The default selection is Gold Foil.
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Single Folil Printing

Single Ink printing uses just one color. This method is used when an entire
image or document is going to be printed in a single color.

This method of printing can be used even when the application you are using
does not allow designation of color compositions.

Requirements

For single color printing you will need the following cartridges and cover types.

e Premium Foil Cartridges

Premium Gold Foil cartridge
Premium Silver Foil cartridge
Premium Red Foil cartridge
Premium Blue Foil cartridge
Premium Green Foil cartridge
Premium Black cartridge
Premium White cartridge
Primer cartridge (“Undercoat”)

The primer cartridge is required when printing on ClearCovers, and it may
improve the print quality on other cover types. The primer cartridge will be
used for printing when the Undercoat checkbox is checked.

 Foilfast Compatible Covers
Foilfast™ Composition Cover
Foilfast™ Coated Paper Cover
Foilfast™ ClearCover™

Step 1» Create a Document for Single Ink Printing

Use any application to create the image or document you want to
print, and prepare it just as you would for normal printing.

D/ Note
Itis not necessary to select acolor in the application that matches

the color of the cartridge in the printer. Leaving the characters
and images in black is fine.

Step 2» Install the Foil Cartridge

Install the cartridge you want to print with in the cartridge holder.

34



WINDOWS - Printing Operations

Step 3» Load Cover Sheets

Load up to 10 composition covers; ClearCovers must be fed one at a time.

1. Pull up the support.
Support

2.  Place the sheet(s) in the sheet feeder.

D/ Note
* Using creased or curled sheets can cause the sheet to

misfeed.

* Fanthe stack once before placing it in the feeder. The printer
may feed two sheets together if the sheets are slightly stuck
together.

* Use only one type of sheet at a time.

* Place a stack of not more than 10 composition covers or 1
sheet ClearCover in the feeder.

3. Adjust the feed guide to the proper size.

Leave about 0.02” between the feed guide and the sheet(s).
The stopper will prevent the sheets from rising.

St
Feed guide opper
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D « If the space is too wide, a sheet may feed diagonally.

« If the space is too narrow, a sheet may not feed.

Step 4» Set Up the Printer Driver for Printing

1. Select Print from the File menu to open the Print dialog
box, then click Properties.

36



WINDOWS — Printing Operations

3. Select Single Ink from the Print Mode menu (for single foil
color printing).

4. Click the appropriate radio button to select the cartridge(s)
you wish to use.
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5. Setthesize,orientation,and number of copies as desired.
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6. When you complete the setup, click OK to close the dia-

log box.

Step 5» Print

Click OK in the Print dialog box to start printing.
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Multiple Foil Printing

Use the steps outlined below for printing with two or more colors. Designate
each foil color with a corresponding color in your application. You can use this
method with most applications that support color.

Requirements
For multiple foil color printing you will need the following.

e Premium Foil Cartridges
For foil printing at least one cartridge is required.
Premium Gold Foil cartridge
Premium Silver Foil cartridge
Premium Red Foil cartridge
Premium Blue Foil cartridge
Premium Green Foil cartridge
Premium Black cartridge
Premium White cartridge
Primer cartridge (“Undercoat”)

The primer cartridge is required when printing on ClearCovers, and it may
improve the print quality on other cover types. The primer cartridge will be
used for printing when the Undercoat checkbox is checked.

« Foilfast Compatible Covers
Foilfast™ Composition Cover
Foilfast™ Coated Paper Cover
Foilfast™ ClearCover™

Step 1» Create a Document for Multiple Ink Printing

1. Use any application to create the image or document you
want to print, and prepare it just as you would for normal
printing. The image may contain text as well as graphics.

2. Select the application colors that correspond to each
Foilfast color you wish to use.

For example, set the parts of the image that you want to print
in gold foil to yellow. If you are also using black, set the parts
of the image that you want to print in black to black.

D/ Note
Many applications have color palettes that allow easy selection

of foil colors.
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The colors associated with foil colors are shown in the following table.

m Colors used to indicate foil colors

In multiple color printing, indicate foil colors by selecting colors in the ap-
plication that resemble the foil colors.

As much as possible, try to select colors that resemble the foil colors to be
printed. In applications that do not have many color choices, such as
word processors, closely related colors can be used. In this case, how-
ever, check the color output by executing a test print to make sure the
correct foil colors are printed.

Foil color Application color

Gold Foil Yellow

Silver Foll Dark Gray

Red Foil Red

Blue Foil Blue

Green Foil Green

White Light gray (a gray close to white)

Black Normal black
Set this area to black Set_ this_ area to b_Iue
(prints in black) (prints in blue foil)

] %

T
SEASONS GREETINGS .+

Set this area to red -

(prints in red foil)

Set this area to
light gray
(prints in white)

Set this area to blue
(prints in blue foil)

Set this area to yellow
(Prints in gold foil)

Step 2p» Install the Foil Cartridge

Install the cartridge you want to print with in the cartridge holder.
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Step 3» Load Sheets

Load up to 10 composition covers; ClearCovers must be fed one at a time.

1. Pull up the support.
Support

2. Place the sheet(s) in the feeder.

D/ Note
* Using creased or curled sheets can cause a sheet to misfeed.

« Fanthe stack once before placing it in the feeder. The printer
may feed two sheets together if the sheets are slightly stuck
together.

¢ Useonly one type of sheet at a time.

« Place a stack of not more than 10 composition covers or 1
ClearCover in the sheet feeder.

3. Adjust the feed guide to the proper size.
Leave about 0.02” between the feed guide and the sheet(s).
The paper stopper will prevent the sheets from rising.

Feed guide
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D « If the space is too wide, a sheet may feed diagonally.

« If the space is too narrow, a sheet may not feed.

Step 4» Set Up the Printer Driver for Printing

1. Select Print from the File menu to open the Print dialog
box, then click Properties.
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3. Select Multiple Ink from the Print Mode menu.

4. Check the check boxes under Select Cartridge(s) to indi-
cate your desired colors.

et Rt B

D Even though you have set the color of an area to your de-

sired color, the area will not be printed if the corresponding
color foil cartridge has not been checked.
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5. Setthesize,orientation,and number of copies as desired.
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6. When you complete the setup, click OK to close the dia-
log box.

Step 5» Print
Click OK in the Print dialog box to start printing.
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Installing the Printer Driver for Macintosh

Before you can use your printer, you need to install the printer driver software so that
your computer can work with the printer.

This section describes how to install the printer driver. These directions assume that
you are familiar with normal Macintosh operations, such as using the mouse and menus.
Please refer to the user’s guide that came with your Macintosh if you need information
about general Macintosh operations.

Purpose of the Printer Driver

The printer driver is software that enables your computer to control the printer.
When printing from any application, you must select a printer driver that matches
the printer being used in order to ensure accurate printing results. To take advan-
tage of the many features of the printer, select the Foilfast printer driver before
creating your documents.

Preparing for Installation

Before installing the printer driver, check your hard disk with the Disk First Aid
utility to make sure that it has no serious problems.

Refer to the Macintosh manual for information about using Disk First Aid.

System Requirements

The system requirements for the printer driver are as follows:

Computer: Apple Macintosh computer or compatible
Operating system: System 7.0.1 or later
Total RAM: 16 MB or more (32 MB or more is recommended)

Disk space required during printing (approximate):
Single color, 10 MB

Multiple colors, 40 MB

D/ Note
The working disk space needed during printing is automatically

erased after printing is completed.
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Contents of the Installation Disc

The files shown below are contained on the Installation Disc (CD-ROM).
The installer installs the following files:
« Foilfast printer driver
» USB Class Driver (USB equipped system only)
» Queue Monitor (background printing application, before System 7.6.1 only)
» Queue Watcher (background printing extension, before System 7.6.1 only)

Installing the Printer Driver

Double click the “PPI Foilfast Installer” to begin installation, or read the “Readme”
file for detailed instructions.
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MACINTOSH — Installing the Printer Driver for Macintosh

Using Balloon Help

With System 7.0.1 or later, Balloon Help can be used to explain the functions of
the printer driver buttons, check boxes, and radio buttons. By displaying Balloon
Help, you can get a simple explanation of each function.

Follow the steps below to use Balloon Help.

1. Select Show Balloons from the Help menu (found on the

menu bar, at the upper right corner of the screen).

2. Move the cursor over the button or box to be explained.

POWIS Foilfast Printer Page Setup P PALOMAR 10 -
Wl e

To print a reduced or enlarged
copy of ywour docurnent, type a

o percentage of reduction or
enlargement here. (For example,
100% vields actual zize, SO%
wields half gize, 200% wields
doubled size )

To hide Balloon Help, follow the steps below.

1. Select Hide Balloons from the Help menu.

Selecting the PPI Foilfast™ Printer Driver

If you want to print using the Powis Parker Foilfast Printer, you should select the
Powis Parker Foilfast Printer printer driver in the Chooser before you create docu-
ments in your application. If you want to print documents created when the Powis
Parker Foilfast printer driver was not selected, first select the Powis Parker Foilfast
Printer in the Chooser, then choose Page Setup from your application’s File menu,
and finally change the application’s page format and other settings if needed.
Follow the steps below to select the Powis Parker Foilfast Printer printer driver.

1. From the Apple menu, select the Chooser.

E Chooser—————— E

M

appleShare  Laserriter 300/LS

2 %

Laseri'riter & FFI Foilfast

i® Active

AppleTalk ) Inactive

4

761
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2.

Click on the PPI Foilfast Printer printer driver icon.
The box on the right displays the SCSI device or USB number

of the Powis Parker Foilfast Printer. (f\)
O=—————(thooser————H
[] Select a part:
= e

AppleShare Laserwriter 200/LS

Laserwriter & E%

Background Printing: 3 On @& Off

@® Active

=| | ApRleTalk ) Inactive

761

Make sure that the line indicated by (A) is highlighted. If it is
not, your printer is not being recognized properly.

If you have several Foilfast printers connected to your
Macintosh, click on the SCSI device or USB number of the
printer you wish to use.

The factory device setting is #6. To change SCSI device num-
bers, refer to “Specifications” in the Appendix.

E:I/ Note
If you have more than one SCSI bus in your Macintosh,“ SCSI #6

BUS #1” or similar will be displayed.

E:I/ Note
Immediately following installation, background printing is turned

off. Click on the On button to enable background printing.

Click on the close box to close the Chooser.

When the selected printer driver is changed from some other
printer driver to the Powis Parker Foilfast printer driver, a dia-
log box will appear to inform you that a different printer has
been selected.

You have changed your current
printer. Please choose “Page Setup...”
in all ofthe open applications.

5.

Click on the OK button to close the dialog box.
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Turning the Power On or Off

Turn your printer and computer on or off by following the steps described below.

Turning on the Power

Turn on the power by performing the following steps.

1. Push the power button on the printer to turn it on.

[

2. Turn on your computer.

Turning off the Power

When you have finished printing, turn off your printing devices by performing the
following steps.

1. Shut down your computer.

2. Push the power button on the printer to turn it off.

3. If you are disconnecting the printer from your computer,
unplug both printer and computer.
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Printing Operations

Print Mode

Foilfast premium foil cartridges come in a range of colors. You may load several
colors into the Foilfast printer at the same time, or you may load just a single
color.

* Single Ink (one foil color)
This print mode allows you to print a document in monochrome using one
cartridge. All selectable cartridges are shown with radio buttons in the Select
Cartridge(s) area in Print/properties. Click the radio button next to the color
you wish to use. The default selection is Gold Foil.

* Multiple Inks (2 or more colors)
This print mode allows you to print a document in multiple colors. Select Mul-
tiple Inks in the Select Cartridge(s) area in Print/properties. All selectable car-
tridges are shown with checkboxes. You must select at least 1 and no more
than 7 colors. The default selection is Gold Foil.
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Single Ink Printing

Single Ink printing uses just one color. This method is used when an entire image
or document is going to be printed in a single color.

This method of printing can be used even when the application you are using
does not allow designation of color compositions.

Requirements

For single color printing you will need the following cartridges and cover types.

e Premium Foil Cartridges

Premium Gold Foil cartridge
Premium Silver Foil cartridge
Premium Red Foil cartridge
Premium Blue Foil cartridge
Premium Green Foil cartridge
Premium Black cartridge
Premium White cartridge
Primer cartridge (“Undercoat”)

The primer cartridge is required when printing on ClearCovers, and it may
improve the print quality on other cover types. The primer cartridge will be
used for printing when the Undercoat checkbox is checked.

« Foilfast Compatible Covers
Foilfast Composition Cover
Foilfast Coated Paper Cover
Foilfast ClearCover

Step 1» Create a Document for Foil Color Printing

Use any application to create the image or document you want to
print, and prepare it just as you would for normal printing.

D/ Note
Itis not necessary to select acolor in the application that matches

the color of the cartridge in the printer. Leaving the characters
and images in black is fine.

Step 2p Install the Foil Cartridge

Install the cartridge you want to print with in the cartridge holder.
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Step 3» Load Cover Sheets

Load up to 10 composition covers; ClearCovers must be fed one at a time.

1.  Pull up the support.
Support

2. Place the sheet(s) in the feeder.

D/ Note
* Using creased or curled sheets can cause the sheet to

misfeed.

» Fan the stack once before placing it in the sheet feeder. The
printer may feed two sheets together if the sheets are slightly
stuck together.

* Use only one type of sheet at a time.

* Place a stack of not more than 10 composition covers or 1
ClearCover into the feeder.

3. Adjust the feed guide to the proper size.

Leave about 0.02” between the feed guide and the sheet(s).
The stopper will prevent the sheets from rising.

St
Feed guide opper
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D/ Note
« If the space is too wide, a sheet may feed diagonally.

» If the space is too narrow, a sheet may not feed.

Step 4p» Set Up the Printer Driver for Printing

Select Page Setup from the File menu to open the Page

Setup dialog box.

Set any necessary settings, such as Size or Orientation,

depending on the document to be printed.

mt Foilfast Printer Page Setup [ PACAMAE 1 m
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Once the settings have been selected, click OK.

Step 5» Print

Select Print from the File menu.

wi Follfast Printer [T e T E
hioia:  |_Foitlast Comg Cover = HiGH w | [ Lper Desined, | [_tancel |
et (Provview |

Copbes Pages: @am Qivom: [ |t [ |

fptians: [] Prist Back To Fromnt L] Drvpriay

] vndierenal [ Daubli Padis Pristing
— kel Cart ¥
[ ®caldron [ G Silver Fail [semtun. |
[ LT B & Green rail 3 Bt el
W 3 Mack ] G Wbt

53



Chapter 1 — Major Functions and Operations

2. Select your cover type from the Media menu.
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3. Select Single Ink from the Mode menu.
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4. In the Select Cartridge(s) area, click the radio button(s)
next to the colors you wish to use.
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5. Select Options and number of copies as desired.
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6. When you complete the setup, click Print to close the dia-
log box.

Step 5» Print

6. Click Printin the Print dialog box.
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Multiple Foil Printing

Use the steps outlined below for using two or more foil cartridges. Designate
each foil color with a corresponding color in your application. You can use this
method with most applications that support color.

Requirements

For multiple foil color printing you will need the following.

* Premium Foil Cartridges

Premium Gold Foil cartridge
Premium Silver Foil cartridge
Premium Red Foil cartridge
Premium Blue Foil cartridge
Premium Green Foil cartridge
Premium Black cartridge
Premium White cartridge
Primer cartridge (“Undercoat”)

The primer cartridge is required when printing on ClearCovers, and it may
improve the print quality on other cover types. The primer cartridge will be
used for printing when the Undercoat checkbox is checked.

» Foilfast Compatible Covers
Foilfast Composition Cover
Foilfast Coated Paper Cover
Foilfast ClearCover

_______________________________________________________________________________________________________|
Step 1» Create a Document for Multiple Foil Printing

1. Useany application to create the image or document you
want to print, and prepare it just as you would for normal
printing. The image may contain text as well as graphics.

2. Select the application colors that correspond to each
Foilfast color you wish to use.
For example, set the parts of the image that you want to print
in gold foil to yellow. If you are also using black, set the parts of
the image that you want to print in black to black.

E:I/ Note
Many applications have color palettes that allow easy selection

of foil colors.
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The application colors associated with foil colors are shown in the following table.

m Colors used to indicate foil colors

In multiple foil color printing, indicate colors by selecting colors in the ap-
plication that resemble the foil colors. As much as possible, try to select
colors that resemble the foil colors to be printed.

Foil color Application color

Gold Foil Yellow

Silver Foil Dark Gray

Red Foil Red

Blue Foil Blue

Green Foll Green

White Light gray (a gray close to white)

Black Normal black
Set this area to black Set this area to blue
(prints in black) (prints in blue foil)

SEASON'S GREETINGS .+
Set this area to red .,
(prints in red foil)

Set this area to
light gray
(prints in white)

Set this area to blue
(Prints in blue foil)

Set this area to yellow
(Prints in foil gold)

Step 2p Install the Foil Cartridges

Install the cartridge you want to print with in cartridge holder.
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Step 3» Load Sheets

Load up to 10 composition covers; ClearCovers must be fed one at a time.

1. Pull up the support.
Support

2.  Place the sheet(s) in the sheet feeder.

D/ Note
* Using creased or curled sheets can cause a sheet to misfeed.

« Fanthe stack once before placing it in the feeder. The printer
may feed two sheets together if the sheets are slightly stuck
together.

¢ Useonly one type of sheet at a time.

* Place astack of not more than 10 sheets composition covers
or 1 ClearCover into the sheet feeder.

3. Adjust the feed guide to the proper size.

Leave about 0.02” between the feed guide and the sheet(s).
The stopper will prevent the sheets from rising.

Feed guide
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D/ Note
« If the space is too wide, a sheet may feed diagonally.

« If the space is too narrow, a sheet may not feed.

Step 4 Set Up the Printer Driver for Printing

1.

Select Page Setup from the File menu to open the Page

Setup dialog box.

Set any necessary settings, such as Size or Orientation,

depending on the document to be printed.
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Once the settings have been selected, click OK.

Step 5» Print

1. Select Print from the File menu.
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2. Select your cover type from the Media menu.
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3. Select Multiple Inks from the Mode menu.
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4. Inthe Select Cartridge(s) area, click the radio buttons next
to the colors you wish to use.
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D/ Note
Even though you have set the color of an area to your de-

sired color, the area will not be printed if the corresponding
cartridge has not been checked.
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6. Click Preview in the Print dialog box to confirm that the
specified foil colors are correct.

The Preview window shows the foil colors that will actually
print rather than those specified by the application.

Caution

The foil color that is assigned may differ from your intended foil
color, so be sure to check the Preview window before printing.

9. When you are satisfied with the contents of the Preview
window, click Print Page.

D/ Note
If you are not satisfied with the assigned colors, click on Cancel

and respecify colors in your application.Then click Preview again.
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Chapter 2

The Foilfast Printer Driver

Printer Driver Functions

This chapter describes each of the printer driver settings
required for controlling the printing operations. Read it to
learn the specific setup details for different printing modes.



WINDOWS: Foilfast Printer Driver Setup

How to Open the Printer Driver Setup Dialog Box

You may open the printer driver setup dialog box in one of the following ways.

¢ Select Print from the File menu, and then click Properties in the Print dialog

box.

[ 1 -
Prens
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* Select Page Setup from the File menu. Click Printer in the Page Setup dialog
box, and then click Properties in the displayed dialog box.

E:I/ Note
To access the Foilfast printer properties controls, you must first

select the Powis Parker Foilfast Printer as the printer you wish
to use.
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Print Settings

Media (Cover) Type

Click the down arrow, and select the desired media type
from the displayed settings. The available options are as
follows:

* Foilfast Comp Cover — HIGH

» Foilfast Comp Cover — HIGH

* Foilfast Coated Paper Cover

» Foilfast ClearCover

* User Defined...
Click this button to save your own settings. To do this,
after setting the necessary items, click this button so
that the User Defined Document Type dialog box is dis-
played. Type the document type name in the “Save as”
field, then click the Save button. Up to ten document
types can be saved. To delete a document type, click
the document type name you want to delete in the list,
then click the Delete button.

5 P

NOTE: HIGH and LOW designate power settings for
comp covers. HIGH is the default setting, and we rec-
ommend it for best results.

Paper Size

Click the down arrow, and select the desired sheet size from
the displayed list. The available options are as follows:

[rae i s S NI :'E « Letter 8.5x 11 in

e Legal 85x 14in

* Half Letter 5.5x 8.5in
e A4 210 x 297 mm

¢ A5148 x 210 mm

e B5182 x 257 mm

« User Defined...

To open the User Defined Paper Size dialog box, select
the User Defined... option from the Paper Size menu. In

(P r'_'i FRiniud this dialog, you can create your custom size. Enter the
[ e width and length, and type the name of your custom size.

Then click “Save” to save the settings. Up to ten settings

L= | cew | _/"-‘_I can be saved. To delete a setting, click the saved name in

the list, then click the Delete button.

* Reduce or Enlarge
Scaling can be set between 25% to 400%. This control is
grayed out when you select “User Defined...” (including
user defined names) for paper size. The default setting is
100(%).
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Orientation
This setting sets the sheet orientation.

 Portrait/Landscape
Click one of the radio buttons to set the orientation
ahnComp Lo L to either Portrait or Landscape.
plis el e * Flip Horizontal
Turning on this option prints an image flipped hori-
zontally, the mirror image of the document as it dis-
plays on your screen. You may want to use this fea-
ture when printing in black or white on ClearCovers.
* Upside Down check box
Check this box to print the image 180 degrees ro-

s - FOIL _&‘E_- tated.
W
s - |i ; u

gt | P | ———— Copies

Input the number of copies you wish to print by typing the

Lo | cm | v | number in the edit box.
Print Mode
Fizerm | Click the down arrow, and select the desired print mode
-l R { from the displayed settings. The available options are as
[rei Com-Co - iga =] D =T follows:
M m » Single Ink (one foil color)
) L This print mode allows a document to be printed in
C Tl || e ctga monochrome using a selected cartridge. When you
P m Endege |1 3 __"f"'"‘" Ir_"" select Single Ink mode, all selectable cartridges are
=== T shown with radio buttons in the Select Cartridge(s)
£ Py T Larchomp " ogem Pl area. The default cartridge selection is Gold Foil.
;""-"" ﬂ  Babid S | + Multiple Ink (multiple foil colors)
- This print mode allows a document to be printed in
rﬂ'— FOIL MR multi-color using any selected cartridges. When you
e I"_'; select Multiple Ink mode, all selectable cartridges are
Bt | Bt shown with checkboxes in the Select Cartridge(s) area.
You must select at least 1 and no more than 7 colors.
— ] ] The default cartridge is Gold Foil.

« Undercoat check box
The primer cartridge will be used for printing when
Undercoat is checked. The primer cartridge is required
for printing on ClearCovers, and it may improve the
print quality on other print media. The default setting is
Undercoat off.

* Double Pass Printing check box
When using sheets with a rough texture, you may want
to check Double Pass Printing to increase the density
of the foil. When Double Pass Printing is checked, the
printer prints each line twice. This check box is grayed
out when Foilfast ClearCovers is selected. In the De-
fault setting, the Double Pass printing checkbox is not
checked.

Note

D/ Selecting Double Pass printing will double the foil con-
sumption rate.

* Overlay check box
This option allows two consecutive pages of a docu-
ment to be printed on the same sheet.
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WINDOWS — Print Settings

» Select Cartridge(s)
Click the radio button next to the cartridge(s) you wish to
use.

* Show Status... button
Shows the percent remaining for each installed cartridge.

* Refresh button
Click Refresh button to refresh and update the latest printer
status.

» Close button
Click Close button to close the Show Detail dialog box.

Powis Parker Foilfast Information dialog box
Click the Show Status... button while holding down the
Ctrl and Alt keys to see the ROM version number EEPROM
version number, your printer’s serial number and the num-
ber of printed bands.

OPTION SETTING dialog box
Click the Restore Default button while holding down the
Ctrl and Alt keys to see more printing options.

Micro Feed:
During printing, the image sometimes shows lines at
intervals of approximately 10 mm (0.39"). This occurs when
the line feed amount (distance between the lines) has
gotten too small. You can remove these lines by adjusting
the line feed amount. Move the slider to the left to de-
crease the space between lines. Move the slider to the
right to increase the space between lines.
Slider Setting: Unit = 2/5600" (9 pm)
Range = -45 pm ~ +45 um

Density:
This option allows you to adjust the print density.
Slider Setting: Unit =2°C
(reference ambient temperature)
Range =-10°C ~ +10°C
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MACINTOSH: Printer Driver Functions

This chapter explains how to use the Foilfast printer driver. The main sections are:

* Using the Chooser
» Page Setup Dialog Box
 Print Dialog Box

Using the Chooser

The Chooser, found under the Apple menu, is part of the system software and
can be opened from the Finder or from within an application.

When you use the Powis Parker Foilfast for the first time, or when you switch to
the Foilfast after using another printer, use the Chooser to select the new printer.
Once you've selected a printer in the Chooser, that printer remains the active
printer until you use the Chooser to select a different one.

Chooser Settings

The following window opens when the Chooser is selected from the Apple menu.
[a] hian ser =
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Selecting a Device

A summary of all the devices that may be used is displayed on the left side of the
Chooser window. When there are multiple zones on a network, the left side of the
display appears as shown below.

L a2

AppleTalk Jone

Zafe B

Beckgrasnd Priming O On ff oFf

i Ackive
Q1 Imbzkiva 76.i

Applalalk

Selecting the Port

The SCSI or USB device number of the Powis Parker Foilfast printer is displayed
in the upper right portion of the Chooser window, after you select (click) the PPI
Foilfast driver on the left side. When more than one Foilfast printer is connected
to the SCSI or USB bus, select the device number for the printer you want to use.
When only one Foilfast printer is present, it is not necessary to select the device
number.

O Thesver =]

¥ 2 comm—-

Aphinars Lamrerfae TOOE

2 2

Beckgrosnd Priming O On 8 o

i Ackive

Applalalk N
= [ M- A 761

Note
m If you have more than one SCSI bus in your Macintosh,“ SCSI #6
BUS #1” or similar will be displayed.
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Background Printing

If you installed the Queue Kit software, you can enable or disable background
printing through the Chooser. In the Chooser, select the Powis Parker Foilfast
printer in the Background Printing section, select the On radio button to enable
background printing or the Off button to disable it. When the software is first
installed, background printing is off.

Background Printing: ) On @ Off

& Active

appleTalk .
) lnactive 2 6.0

E:I/ Note
Background printing cannot be selected if the Queue Kit soft-

ware is not installed.

Using AppleTalk

Because the Foilfast printer connects to the Macintosh SCSI port rather than the
AppleTalk port, you can turn AppleTalk on or off, as you wish, without affecting
operation of the Foilfast printer.
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Page Setup Dialog Box
Select Page Setup from the File menu. The Foilfast Page Setup dialog box ap-

pears.
Mi Failiast Printer Fagpe Sebip Ew 1 m
Slaw: LS Leflar w |_cancel |
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Size

From the Size menu in the Page Setup dialog box, you can select one of the
following page sizes:

eletter8.5x11in
*Legal 8.5x 14 in

e Half Letter 5.5 x 8.5 in
* A4 210 x 297 mm

* A5 148 x 210 mm
*B5 182 x 257 mm

WE Fanillask Printer Fage)
)

Drsenratinn Printer EMects;

| JUS = Er

Custom Page Sizes (Edit Button)

To create custom paper sizes, click Edit in the Page Setup dialog box. The Edit
Paper Sizes screen appears.

Page sizes Page size and printable area display
it Pager Slins

S —
wiomn: [ |
S —
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To create a new page size, click “New”, enter a new name, height, and width,
then click Add. The new page size will appear in a list in the left portion of the
window. To change a setting, click on the name in the page sizes list and change
the page length and width. To delete a size, click on the name and then click
Delete.

The Page Size and Printable Area appears on the right side of the Edit dialog
box. You can switch between the graphical and the text previews by clicking in the
Preview box. This also works in the Page Setup dialog box.

D/ Note
When entering the page size, you must also enter the unit of

measurement. For example, if you type in “5"", the size will be
set to 5inches, and if you type in“5 mm”, the size will be set to
5mm.

Reduce or Enlarge

The Page Setup dialog also contains a Reduce or Enlarge box, in which you can
enter percentages ranging from 25 to 400. The document is printed smaller or
larger depending on the percentage you choose. The default setting is 100 per-
cent.

Orientation

Click on the icon for landscape printing to print documents in landscape orienta-
tion or portrait for portrait orientation.

Printer Effects

Flip Horizontal and Upside Down can be turned on or off by clicking the corre-
sponding check box in the Printer Effects section.

Flip Horizontal flips the image left to right, to print a mirror image of your docu-
ment as it displays on your screen. You may want to use this feature when print-
ing in black or white on ClearCovers.

Upside Down rotates the image 180 degrees before printing.

OK/Cancel
If the new settings are satisfactory, click OK. Otherwise, click Cancel.
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Print Dialog Box

Select the Print from the File menu. The Foilfast Print dialog box appears.
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D/ Note
When you select Print from the File menu, the Print dialog box

may display not only the Foilfast settings but also additional
settings specific to the application you are using. For these set-
tings, refer to you application’s user’s manual.

Media (Cover Type)

From the Media menu in the Page Setup dialog box, you can select one of the
cover types listed below.

Fmt Foilfast Printer i[5 R E
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« Foilfast Comp Cover — HIGH
« Foilfast Comp Cover — LOW
* Foilfast Coated Paper Cover
* Foilfast ClearCover

D/ Note
HIGH and LOW designate the power settings for comp covers.

HIGH is the default setting, and we recommend it for best re-
sults.
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Mode
Select the desired print mode from the displayed settings.
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» Single Ink (one foil color)

This print mode allows you to print a document in monochrome using one
cartridge. All selectable cartridges are shown with radio buttons in the Select
Cartridge(s) area in Print/properties. Click the radio button next to the color
you wish to use. The default selection is Gold Foil.

Multiple Inks (2 or more colors)

This print mode allows you to print a document in multiple colors. Select Mul-
tiple Inks in the Select Cartridge(s) area in Print/properties. All selectable car-
tridges are shown with checkboxes. You must select at least 1 and no more
than 7 colors. The default selection is Gold Foil.

Copies

In the Copies box, enter a number between 1 and 99.

Pages

Select either one of the radio button

s: All or From/To. When you select From/To,

you can specify a range of pages to print.

Print Back to Front (check box)

Pages are print in reverse order, beginning with the last page.

Overlay (check box)

Printing is executed in the Overlay mode. In the overlay mode, pages one and

two of the document are printed on the same page.
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MACINTOSH — Printer Driver Functions

Undercoat (check box)

The primer cartridge will be used when this checkbox is checked. The primer
cartridge is required when printing on ClearCovers, and it may improve the print
quality on other print media. The default setting is Undercoat off.

Double Pass Printing (check box)

When using sheets with a rough texture, you may want to check Double Pass
Printing to increase the density of the foil. When Double Pass Printing is checked,
the printer prints each line twice. This check box is grayed out when Foilfast
ClearCover is selected. In the Default setting, the Double Pass printing checkbox

is not checked.
D/ Note
Selecting Double Pass printing will double the foil consumption

rate.

User Defined button

The user Defined dialog allows you to designate the properties for printing on
customer cover types. The following print setting options will be saved with your
specified cover type name.

* Micro Feed adjustment and density adjustment
* Printer Effects (Flip Horizontal and Upside Down)
* Print Mode, Select Ink Cartridge(s) and Undercoat
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Micro Feed

During printing, the image sometimes shows lines at intervals of approximately
10 mm (0.39"). This occurs when the line feed amount (distance between the
lines) has gotten too small. You can remove these lines by adjusting the line feed
amount. Move the slider to the left to decrease the space between lines. Move
the slider to the right to increase the space between lines.

Slider Setting:  Unit = 2/5600" (9 um)
Range = -45 pm ~ +45 pm
Density
This option allows you to adjust the print density.
Slider Setting:  Unit = 2°C (reference ambiance temperature)
Range =-10°C ~ +10°C
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Chapter 2 - Foilfast Printer Driver

To create a new custom cover type, choose one of the factory standard cover
types and select the desired settings before clicking the User Defined button.
Adjust Micro Feed and Density if necessary. Then, enter your cover type and
click Add. The new cover will appear under the separator line in the Media list.
You can create up to 29 new custom covers. To delete a cover type, select the
name from the Media menu and click the User Defined button, then click Delete.

Select Cartridge(s)

Foilfast premium foil cartridges come in a range of colors. You may load several
colors into the Foilfast printer at the same time, or you may load just a single
color.

» Single Ink (one foil color)
This print mode allows you to print a document in monochrome using one
cartridge. All selectable cartridges are shown with radio buttons in the Select
Cartridge(s) area in Print/properties. Click the radio button next to the color
you wish to use. The default selection is Gold Foil.

e Multiple Inks (2 or more colors)
This print mode allows you to print a document in multiple colors. Select Mul-
tiple Inks in the Select Cartridge(s) area in Print/properties. All selectable car-
tridges are shown with checkboxes. You must select at least 1 and no more
than 7 colors. The default selection is Gold Foil.

Status button

Shows the percent remaining for each installed cartridge. NOTE: Firmware Ver-
sion, EEPROM Version, Serial No. and Number of Printed Lines will not display
while printing in the background using a USB connection.
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Close button

Click the Close button to close the Show Detail dialog box. While the Option key
is held down, click the Status button to display the Options dialog. When the
Complete Print Job check box is selected, your print job will be monitored until
printing is complete. Note that it will always monitor the print job completion while
printing in background.
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Refresh button
Click the Refresh button to refresh and update the latest printer status.

Print
Click Print to start printing according to the current print settings.

Cancel
Click Cancel to discard the changes and close the Print dialog box.

Preview

In the Print dialog box, click Preview to display an image of the page exactly as it
will print. Note that the Preview image quality depends on your monitor’s current
color level.

Wiraf et - Sl mk |

Use the left and right arrow buttons in the Preview window to scroll through the
pages. To display a specific page number, click in the page number box and type
in the number of the page you want to see.

E Fage :l-rd

Click one of the Zoom buttons to display the page reduced (to fit in the window),
normal (actual size), or enlarged (dot for dot at your screen resolution).

Hala

Click Print Page to print only the page currently displayed. Click on the Print Page
button while holding down the Option key to print all the pages. Click on the
Cancel button to close the Preview window without printing.
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Using Background Printing

This section explains how to use background printing for Macintosh operating systems
7.6.1 or earlier. If your Macintosh is running on System 7.6.1 or later, the standard
desktop printer will be used for background printing.

Background Printing

Background printing allows the computer to do other jobs while a document is
printing.

1. To use background printing, select the Chooser from the
Apple menu.
When the Chooser window appears, click on the PPI Foilfast
printer driver icon in the left half of the window. A list of at-
tached Foilfast printers appears in the right half of the window.
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2. Click on the SCSI # corresponding to the Foilfast printer
that you want to use. (If there is more than one listed, each
will have a different SCSI device number.)

Once you have selected the printer to use, click the On radio
button in the Background Printing section of the window. Then
click the close box to close the Chooser window.
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D/ Note
* When the printer software is first installed, background print-

ing is off. Once you have turned background printing on
through the Chooser, it remains on until you use the Chooser
to turn it off again.

= Applalalk

*« Sometimes, depending on the system environment, printing
will fail to start when background printing is enabled. If this
happens, disable background printing and print your docu-
ment using foreground printing.

Using the Queue Monitor

Background printing is controlled through the Queue Monitor. Using the Queue
Monitor, you can view the status of print jobs, pause and resume printing, rear-
range the order of print jobs in the queue, and cancel print jobs.

The Queue Monitor appears only when background printing is on. When back-
ground printing is on, and you choose Print to start printing a document, the
Queue Monitor is automatically launched. The print job is quickly “spooled” (tem-
porarily saved to your hard disk), and then the Queue Monitor takes over the job
of feeding the spooled print job to the printer. Once the Queue Monitor has taken
over printing in the background, you can start using your Macintosh for other
tasks.

To bring the Queue Monitor window to the foreground so that you can check the
status of print jobs, select Queue Monitor from the application menu at the upper
right corner of your screen (at the far right edge of the menu bar).
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When the Queue Monitor window is displayed, selecting Close from the File
menu hides the window.

Preferences settings

To display the Queue Monitor Preferences dialog box, bring the Queue Moni-
tor to the front (click on its window or choose Queue Monitor from the appli-
cation menu) and then choose Preferences from the Queue Monitor’s File
menu.
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If the “Show when printing” check box is checked, the Queue Monitor win-
dow will be displayed during printing.

In the “When printer needs attention” section of the Preferences dialog box,
you can select what alerts will be displayed when Queue Monitor needs
attention during printing. You can choose to have a diamond displayed on
the Apple menu, a diamond plus a flashing icon, or a diamond and flashing
icon plus an Alert box. If you check the Audible notification check box, you’ll
receive an audible warning as well.

Choose Stop Printing from the Queue Monitor’s File menu to pause printing.
Choose Resume Printing from the same menu to restart printing.
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Queue Monitor Window

The Printing box displays the name of the document currently printing, while the
Waiting box displays the names of waiting documents, in the order in which they
will print.

The current print job and any of the print jobs in the queue can be cancelled by
clicking on the Cancel Printing button. To cancel any of the print jobs in the queue,
highlight the documents in the Queue box and then click on the Cancel Printing
button.

To change the order of documents in the queue, highlight the documents and
then drag them with the mouse to their new position within the queue.

The printer status is displayed in the Message Area.
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Error Display

When the printer settings are invalid or when printing stops for some reason, an
error message is displayed.

If an error message appears while you are changing printer settings, correct the
settings according to the error message.

If an error message occurs while printing, refer to the “Troubleshooting” section
to remedy the error and continue printing.
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The Appendix describes maintenance and troubleshoot-
ing procedures, and the basic specifications of the printer.



Cleaning the Foilfast Printer

We recommend that you clean this printer periodically to ensure satisfactory long term
operation.

Cleaning the Printer

Follow the cleaning steps described below.

1. Unplug the printer.
Make sure you unplug the printer before cleaning it.

2. Clean the outside of the printer.

Use a soft cloth to wipe the outside of the printer to avoid dust
and dirt build-up.

2. Push the front cover release button and gently lower the
front cover.

3. Clean the inside of the printer.
Use a soft brush to brush away dirt and dust.
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WINDOWS & MACINTOSH — Cleaning the Printer

Caution

Brush very gently around electrical components, and be careful
not to leave any brush hairs on or near these components.

Cleaning the Print Head
Follow the steps below, using isopropyl alcohol and a cotton swab.

Caution

« Make sure to unplug the printer before cleaning it.

« Do not use benzene, thinner, or other volatile materials, as
they may damage the printer components.

« Do not get the inside of the printer wet.

1. Push the front cover release button and gently lower the
front cover.

2. Wipe the print head with a cotton swab dipped in isopro-
pyl alcohol.
The print head may not come clean in one wipe so repeat
several times.

Platen
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Caution

« Avoid getting alcohol on the platen.
« Wait until the alcohol dries before printing.
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Cleaning the Platen
Use cellophane tape to clean the platen as described below.

Caution

Make sure to unplug the printer before cleaning it.

1. Pressthe front cover release button and gently lower the
front cover.

2. Gently apply the tape to dirty spots on the platen, and rub
your finger over the tape.

White Pad Platen Cellophane tape

Caution

Do not touch or remove the white pad on the left side of the
platen. Doing so may damage the printer.

3. Slowly peel off the tape.
Repeat as necessary to remove dirt from the platen.
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WINDOWS & MACINTOSH — Cleaning the Printer

Cleaning the Feed Roller

Use isopropyl alcohol and a cotton swab to clean the feed roller as described
below.

Caution;

« Do not use benzene, thinner, or other volatile materials, as
they may damage the printer components.

« Do not get the inside of the printer wet.

1. Initialize the printer
The printer must be initialized for cleaning the feed roller.

Turn off the printer first, then press the Power button to turn on
the printer.

2. Open the front cover

Push the front cover eject button and gently lower the front
cover.

3. Secure the carriage

Press the ready/insert button on top of the printer to move the
carriage to the safety position.

4. Clean the feed roller

Wipe the feed roller (metal shaft roller) with a cotton swab
dipped in isopropyl alcohol. The feed roller may not come clean
in one wipe, so repeat several times.

Feed Roller

Caution:

« Avoid getting alcohol on the platen.
*Wait until the alcohol dries before printing.

5.  Turn the feed roller
Press the ready/insert button on top of the printer to turn the
feed roller. Wipe the feed roller (metal shaft roller) with a cot-
ton swab, repeat until clean.

6. Close the front cover

Close the front cover after you've finished cleaning the feed
roller. The printer will be ready for printing.

87



Appendix

Indicator Lights Summary

Normal Printing Mode

B Indicator light status

Light Light status

Printer status

Ready for operation

power

Printing sample page

Not ready for operation

Select mode (ready to print)

ready

Deselect mode (not ready to print)

Receiving/processing data

error

Printer error detected

@ 5| 8|0 @00

Normal

‘O-=on = fastblinking € = slow blinking

@ = off

B Alarm status shown by indicator lights

Light Status L
Status Description
power | ready | error
Hardware error An electrical circuit error has occurred
Nonvolatile error .. | The contents of the printer's nonvolatile
O O O | memory have been lost
The printer is out of sheets
Out of sheets (detected during sheet feed)
Sheet jam A sheet jam was detected
Ribbon end The foil in the cartridge has been
detected used up
An error was detected during a
Cartridge change cartridge exchange, or there are eight
error » ... |cartridges installed in the holders plus one
O (@} O |already on the carriage
) An error was detected in the printer
Mechanism error .
mechanism
Front cover open The front cover is open
Necessary cartridge The necessary cartridge is not installed
not installed or is used up. Forced printing is
still possible.
‘O-=on ( =fastblinking @ = off
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WINDOWS & MACINTOSH — Troubleshooting

Troubleshooting

What to do if a cartridge is stuck in the carriage

Remove the cartridge as follows:

1. Turn off the power.

2. Open the front cover and remove all cartridges on the
cartridge holder plates.

3. Closethe front cover, and turn on the power.The carriage
will reset.

What to do when an error occurs

When a printer error occurs, the error light flashes, and the error message dialog
box appears on your computer's screen.

power  ready error
O o) ¢
O-on @ off O fast blinking

1. Check the error message

The error message dialog box appears on your computer's
screen.

/ Note:
The error message dialog box cannot display if your computer

is not capable of bi-directional printing, as is the case with some
older machines.

2. Fix the problem
Fix the error to continue printing, or terminate printing.
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The ready/insert button
The readyl/insertbutton is used for a variety of functions, depending on the printer status.
The functions during normal printing are described below.

* Sheet feed and eject
Sheet feed
When the sheet is not fed (error light is blinking), press the ready/insert button to feed
the sheet.
Sheet eject
If sheet is already in the printer and no data is being received (ready light is on), press
the ready/insert button to eject the sheet.

* Canceling an alert
To cancel an alert for anything other than a hardware or mechanism error, press the
ready/insert button after fixing the problem that caused the alert.

* Forced printing and clearing data

When the data transfer from the computer stops for more than about 30 seconds, and
the ready light is blinking quickly, press the ready/insert button to force the printer to
print the data it has received so far.

90



WINDOWS & MACINTOSH — Troubleshooting

Clearing Sheet Jams

Follow these steps to clear a sheet jam.

1. Press the power button to shut off the power.

2.  Press the front cover release button and gently open the
front cover.

3. Press the release lever and gently pull out the jammed
paper.
Jams can be caused by a dirty platen. Clean the platen follow-
ing the directions in the “Cleaning the Platen” section of this
Appendix.

Release lever

4. Close the front cover.

5. Press the power button to turn on the power.




Troubleshooting for Windows

When problems occur during operation of the printer, please check the following
troubleshooting tips.

1  Power dOES NOt COME OMN ..oovvvvuiieiiiiiiiiie et e et e e e e e s

2 Printer errors cannot be detected by the printer driver or the printer
driver cannot tell which cartridge is in which holder ..........................

Printer does not print or stops while printing ........ccccovveeeeeiiiciiinenn.
Printing is light, distorted, or has gaps ......ccccccceeeeeviiiiiiicee e,

Printing is not working or is extremely SIOW ...........ccccevviveeeeeeiiciiieenn.

o 00 b~ W

Sheet is not feeding correctly or not ejecting correctly
from the sheet fERUEr ........ov i

7 Printer makes strange noises when the power
is turned on and the error lights blink .........ccccciiiiiiiii e,

8 Mechanism or Cartridge ErrOr .....uuuiie e
9 Cartridges are not correctly recognized ........ccoecvveeeiieiiiiniiiiieieee s
10 Print QUANITY .oeeeiieiiiiiiiiiee ettt
11 ConNection MEthod .......coociiiiiiiiie e

12 Other problems and OPerations .........ccccceeeieiiiiiiiiiiee e

1. Power does not come on

Is the power cord disconnected?

Make sure the power cord is plugged into an outlet as well as connected to
the printer. After checking the power cord, push the power button to turn on
the printer.

Is the printer plugged into an extension block or power strip?

After turning on the extension block or power strip, press the power button
on the printer.

2. Printer errors cannot be detected by the printer driver
or the printer driver cannot tell which cartridge is in
which holder

Does your computer have a bi-directional port? Is the cable bi-directional?

1= Windows 95/98 Plug & Play installation and bi-directional interfacing with
the printer are only possible if your computer supports bi-directional paral-
lel ports and you are using a bi-directional cable.
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3. Printer does not print or stops while printing

Is the printer turned on?
Before printing make sure the printer is turned on.

Is the front cover closed properly?
Make sure that the front cover is closed properly.

Is the ready light off?
Press the ready/insert button and make sure that the ready light comes on.

Is the interface cable correctly connected?

After connecting the cable, make sure nothing is putting pressure on the
cable, and tighten the fastening screws and clamps to secure the cable.

Is there a sheet jam?

Remove the sheet. If the sheet is caught in the rollers, open the front cover,
push down on the release lever, and gently remove the sheet.

Are the settings in the application correct?
Recheck the printer settings in the application.

Is the printer driver correctly installed?
Install the printer driver from the Installation Disc.

Is the cable disconnected?
When one of the followings occurs, it is possible that the cable is broken or
disconnected.
1) The gauge in the Print dialog box does not progress.
2) The “Out of Sheets” message appears repeatedly.
Replace the cable with a new one.

Are you using a printer selection switch or a printer buffer?
With bi-directional interfaces, operation is sometimes unreliable when us-
ing printer switching boxes or printer buffers. If you are using a printer se-
lection switching box or printer buffer, use one-way communication.

Is your cable too long?
Do not use a cable that is longer than you need. The signals become more
unstable as the cable gets longer.

Are you using the wrong cartridges?
Use the correct cartridges. The Foilfast printer will only accept Foilfast™
premium foil cartridges.

Are the cartridges correctly installed?
Insert cartridges in the holders with the B side up.
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Is the foil in one of the cartridges all used up?
When the foil in a cartridge has been spent, black and silver stripes will be
visible on the ribbon. Install a new cartridge. After replacing the cartridge,
printing will continue from where it left off.

Do you have enough hard disk space?
The Foilfast requires work space on the hard disk when it prints. Keep
enough space open on the disk for the printer to operate. (After printing, the
work space is released.)

Does the hard disk have areas where reading or writing are unreliable?
If there are areas on the hard disk where reading or writing are unreliable,
sometimes a printing error will occur and printing will stop. Periodically use
a utility like SCANDISK that comes with Windows 95/98 to prevent these
problems.

4. Printing is light, distorted, or has gaps

Has one of the foils separated from the head?
Stop the printing and reinstall all the cartridges. Take up any slack in the
foils. If a particular cartridge repeatedly causes problems, try a different
cartridge.

Is the head dirty?
Clean the head by following the directions in this guide for cleaning the
printer and head. The platen often gets dirty at the same time as the head,
so it is recommended to clean the platen after cleaning the head.

Is the platen dirty?
Clean the platen by following the directions in this guide. If anything is stuck
to the platen, remove it, being careful not to damage the platen. The platen
often gets dirty at the same time as the head so it is recommended to clean
the platen as well as the head. If cleaning the head and the platen does not
work, contact the Fastback dealer from whom you purchased the printer.

5. Printing is not working or is extremely slow

Do you have enough disk space?

Make sure there is enough space on your hard disk. (The working space is
released once printing is finished.)

Is the application set for color printing? Does the application support
color printing?
Some applications have color printing enable/disable settings. Some appli-
cations do not support color printing. Read the manual for the application
and check the color settings.
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Are you using many applications at one time?

When very little memory is available for print processing, printing may take
a long time or fail. Close as many applications as possible and try again.

Do you have enough memory?

Handling color images requires a lot of memory for the application and for
the data. Sometimes there is insufficient memory left for printing. Make sure
your computer has enough memory to print the size of images you are
using.

General protection fault errors occur.
These errors can occur when there is insufficient memory for color printing
or when part of the hard disk has become corrupted. After decreasing the
size of the print data or scanning the hard disk, try printing again.

Is the free space on the hard disk fragmented?

The time required for printing can increase dramatically if the free space on
the disk drive is extremely fragmented. Clean up your files and defragment
the disk by periodically running a utility like DEFRAG that comes with Win-
dows.

6. Paper is not feeding correctly or not ejecting correctly
from the sheet feeder

Are you using sheets that are folded or ripped?

The Foilfast printer is compatible only with specific types of cover materials.
Please see page 25, “Identifying Foil Cartridges and Cover Types,” for a list
of compatible cover types.

Are you using a curled sheet?

This will cause sheet jams. The sheet should be curled the opposite way to
flatten it out before it is used.

Are you using sheets with folded or cut corners?

This causes problems since the sheet position sensor and sheet length
sensor do not work properly.

Is there a sheet jam?
Clear the jam.

Is the feed guide too narrow for the sheet?

Set the feed guide so that there is approximately 0.02” between it and the
sheets themselves.

Are there too many sheets in the sheet feeder?
The sheet feeder can hold up to 10 composition covers or 1 ClearCover.
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Is your cover too thick or too thin?

Composition covers should be between 16 — 18.5 points thick (.0016 —
.00185 inches). Clear covers should be between 6.5 — 7.5 points thick (.0065
—.0075 inches). Covers that fall outside the bounds of these thickness ranges
may work in the Foilfast printer, but Powis Parker does not recommend
using them. Covers that fall substantially beyond these thickness ranges
may damage the printer's feeding mechanism and may void your warranty.

Is there anything blocking the output slot (such as a large pile of printed
sheets)?
This can cause ejection or feed problems.

Make sure nothing is on the output tray.

Have you loosened the sheets sufficiently prior to loading them into the sheet
feeder?
Sheets must fanned at least once before they are loaded into the sheet
feeder. If not, sheets may stick to one another, and cause multiple sheets to
feed into the printer at one time, or other forms of misfeeding.

Is the error light blinking?

When the sheet is not fed (error light is blinking), press the ready/insert

button.

If the sheet is not fed even by pressing the ready/insert button, the sheet

feed roller may be dirty. Clean the feed rollers by following the procedures

described below.

(1) Turn off the printer.

(2) The feed rollers are facing the cork pieces on the sheet feed tray, one on
the left, and two on the right as you face the front cover. Wipe the feed
rollers with a cotton swab dipped in water or with a soft wet rag.

Plate Cork pieces

(Feed rollers are across
from them)

(3) Press down the plate of the feed tray as you rotate the feed rollers. Wipe
each roller thoroughly. When the roller makes a turn, the plate of the
feed tray may stay up. However, the plate will come down when the
printer is turned on.

7. Printer makes strange noises when the power is
turned on, and the error lights blink

Has the carriage packing material been removed?
Refer to Chapter 1 of this guide for detailed unpacking instructions.

Has the packing tape on the case been removed?
Refer to Chapter 1 of this guide for detailed unpacking instructions.
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Has a cartridge become dislodged from a cartridge holder?
Open the front cover and make sure the cartridges are correctly installed.

Is there sheet caught between the platen and the print head?
See the section “Clearing sheet jams” and remove the sheet.

8. Mechanism or cartridge error

Are the cartridges correctly installed?

If a cartridge has become dislodged from the holder, a cartridge change
error will occur. Open the front cover and reinstall the cartridge.

Are you using the printer on a level surface?
The printer will not operate correctly on a slanted surface. Place it on a
level, stable surface.

Is the printer in a place where it is subject to bumps or vibrations?

Bumps and vibrations can cause mechanical problems. Place the printer in
a place free from vibrations and bumping.

Is the front cover properly closed?
The printer will not operate correctly if the front cover is not closed properly.
Close the front cover all the way.

Is something sitting on top of the printer?
The printer may malfunction when there are things stacked on top or press-
ing it from the side. Do not place anything on top of the printer.

Is there an obstruction in front of the output slot?

If the output slot is obstructed, sheets ejected from the printer can fold and
bend and cause a malfunction. When printing, make sure that the output
slot is unobstructed and that there is room for sheets to be ejected.

Are you receiving erroneous “cartridge broken” messages?

Remove the cartridge and manually advance the foil, then reinsert the car-
tridge and try again. If the message recurs, try a different cartridge.

9. Foil cartridges are not correctly recognized

Is the code sticker on the cartridge dirty?
Clean the code sticker.

Is the cartridge installed in the holder with the (A) side up?
Make sure the cartridges are placed in the holder with the B side up.

Has a cartridge for a different printer been installed?

Cartridges made by other manufacturers will not work. The Foilfast printer
will only accept Foilfast premium foil cartridges.
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10. Print Quality

There may be superfluous foil on the surface of the sheet after foil printing.
Gently wipe the superfluous foil with a Kleenex or soft cloth.

When using sheets with a rough texture, you may want to check Double
Pass Printing to increase the density of the foil. When Double Pass Printing
is checked, the printer prints each line twice. This check box is grayed out
when Foilfast ClearCovers is selected. In the Default setting, the Double
Pass printing checkbox is not checked.

Smoother sheets will give you a better print quality.

For printing on comp covers, try changing the Media Type setting from comp
cover HIGH to comp cover LOW, or vice versa.

The Foilfast works best with Foilfast branded covers. Other covers may
work, but some may not be compatible.

11. Connection Method

I would like to use a printer switcher.
Since your printer switcher may not support bi-directional communication,
use a uni-directional interface setting.

I would like to use multiple printer ports for connections.

If the computer is AT-compatible, up to three ports (LPT1 to LPT3) can be
used, as long as they are parallel ports.

Can | use the printer on a network?
Yes, the printer can be used on a network, but only with a unidirectional
interface and when set for unidirectional communication.

12. Other problems and operations

How do | delete the printer driver?
For Windows go to Start/Settings/Printers and right-click on the Foilfast
Printer icon, then choose Delete. See the directions in this guide for rein-
stalling the driver.

When my display is set for 64,000 or 16,700,000 colors, | run out of memory
when printing.
Windows runs out of memory when there are many display colors. Change
to 256 colors when printing. Changing the display mode does not change
the print results.

How can | reduce or enlarge my document?
The printer driver software allows you to scale printing. Specify your scaling
factor (25 — 400%) in the Reduce or Enlarge option of your printer driver
software.
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MACINTOSH — Troubleshooting

Troubleshooting for Macintosh

When problems occur during printer operation, please check the following trouble-
shooting tips.

1 Power does N0t COME ON ...civieiiiiiiieeeeeeee e

2 During installation a“File not found” error occurs
or the installer is NOt fOUNd ...

The icon does not appear in the ChOOSEer ........cccooeieiiiiiiiieniieeees
Printer cannot be selected in the ChoOSer .......cccceeviieiiiiiececien,
Printer does not print or stops while printing .........ccccceeiiiiiiinen.
Printing is light, distorted, or has gaps ......cccccoeveeiiiiiee i,

Printing is not working or is extremely SIOW ........cccccceeeiiiieeniieen.

o ~N o o b~ W

Sheet is not feeding correctly or not ejecting correctly
from the sheet feedEer ......oovvviiiiii i

9 Printer makes strange noises when the power
is turned on and the error lights blink .......cccccooeiiiii e,

10  Mechanism Or Cartridge EIrOr ..ouuviieiee e
11 Foil cartridges are not correctly recognized .........cccccveeeeeeeiniiiiineenn.
12 Printing QUANILY ..oooiiiiiiiiiiiiee e
13 Connection Method ........oooiiiiiiii e

14 Other problems and OpPerations ..........cccooceiieiiiiei i

1. Power does not come on

Is the power cord disconnected?
Make sure the power cord is plugged into an outlet as well as connected to
the printer. After checking the power cord, push the power button to turn on
the printer.

Is the printer plugged into an extension block or power strip?

After turning on the extension block or power strip, press the power button
on the printer.
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2. During installation a “File not found” error occurs or
the installer is not found

Is At Ease installed?
If you are using At Ease when you place the Installation Disc in the CD-
ROM drive, the following things may happen. (Some of the Performa series
start up in At Ease.)

« The alert dialog box appears.
e The installer is not displayed.

In these cases the following methods can be used to install the printer driver:

Method 1
From the Special menu, select Switch To Finder. Double-click on the in-
staller icon to install the printer driver.

Method 2

If the Switch To Finder function is not available on the Special menu, select
Switch To At Ease and check the Off checkbox in At Ease settings. Restart
your computer and install the printer driver.

3. The icon does not appear in the Chooser

Is QuickDraw GX enabled?
If QuickDraw GX is installed, disable it by following these steps:

1. Select Control Panels from the Apple menu.

2. Open the Extensions Manager.

3. Deselect QuickDraw GX in the list of items.

4. Close the Extensions Manager, and restart your Macintosh.

Is the printer driver installed?
Install the printer driver from the Installation Disc (CD-ROM).

4. Printer cannot be selected in the Chooser

The USB printer cannot be selected in the Chooser.

Please check the following:

Make sure that the USB interface cable is properly connected to your printer
and your Macintosh, and that the printer is turned on. Then restart your
Macintosh.

If you are using an iMac computer and you are running Mac OS 8.1, make
sure that you have installed the iMac Update 1.0.

Are the SCSI cable and terminator correctly connected?
Correctly connect the SCSI cable and terminator. Make sure that the cable
is not bent excessively. Excessive bending of the cable may break the wires
inside.

100



MACINTOSH — Troubleshooting

Is the SCSI cable loose?

Make sure the SCSI cable connectors are firmly attached at both ends
using the fastening screws or clasps.

Is the SCSI device number set correctly?
Make sure the SCSI device number for the printer is not the same as that
used by any other SCSI device attached to the computer. Each SCSI de-
vice must have a unique device number. (If the computer has more than
one SCSI bus, then the device number must only be unique for the bus that
the printer is attached to.)

Are you using a high impedance cable?
Use a high impedance cable for each device in the SCSI chain.

Is the cable too long?
Do not use a cable that is longer than you need. The signals become less
stable as the cable gets longer.

Is the printer turned on?
Make sure the printer is turned on before using the Chooser to select the
printer.

5. Printer does not print or stops while printing

Is the printer turned on?
Before printing, make sure the printer is turned on.

Were the printer and computer turned on in the wrong order?
Turn the printer on before turning on the computer.

Is the front cover closed properly?
Make sure that the front cover is closed properly.

Is the ready light off?
Press the ready/insert button and make sure that the ready light comes on.

Is the SCSI cable correctly connected?

Make sure the cable is not bent excessively, and secure it firmly at both
ends with the fastening screws or clasps.

Is the terminator connected?
Make sure there is a terminator connected to the last peripheral in the SCSI
chain. If you are using a device with an internal terminator, make it the last
peripheral in the SCSI chain.

Is the device number set correctly?
Make sure the SCSI device number of the printer is not the same as that
used by any other SCSI device attached to the computer. Each SCSI de-
vice must have a unique device number. (If the computer has more than
one SCSI bus, then the device number must only be unique for the bus that
the printer is attached to.)
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Is there a jam?

Remove the sheet. If the sheet is caught in the rollers, open the front cover,
push down on the release lever, and gently remove the sheet.

Are the settings in the application correct?
Recheck the printer settings in the application.

Is the printer driver correctly installed?
Install the printer driver from the Installation Disc (CD-ROM).

Are you using the wrong cartridges?
Use the correct cartridges. The Foilfast printer will only accept Foilfast pre-
mium foil cartridges.

Are the cartridges installed correctly?
Insert the cartridges in the holders with the B side up.

Is the foil in one of the cartridges used up?

When the foil in a cartridge has been used up, black and silver stripes will
be visible on the ribbon. After replacing the cartridge, printing will continue
from where it left off.

Has the printer been selected using the Chooser?
From the Apple menu, select the Chooser and make sure the printer and
device number appear correctly. Click on the printer name and SCSI#. (The
printer may not be selected correctly if you do not click on the printer name.)

Do you have enough hard drive space?
The Foilfast™ requires work space on the hard disk when it prints. Keep
enough space open on the disk for the printer to operate. (After printing,
the work space is released.)

Does the hard disk have areas where reading or writing are unreliable?
If there are areas on the hard disk where reading or writing are unreliable,
sometimes a printing error will occur and printing will stop. Periodically use
the Disk First Aid utility that comes with your system software (or other
commercial disk checking utility) to prevent these problems.

6. Printing is light, distorted, or has gaps

Has one of the foils separated from the head?

Stop the printing and reinstall all the cartridges. Take up any slack in the foil.
If a particular cartridge repeatedly causes problems, try a different cartridge.

Is the head dirty?
Clean the head by following the directions in this guide for cleaning the
printer and head. The platen often gets dirty at the same time as the head,
so it is recommended to clean the platen after cleaning the head.
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MACINTOSH — Troubleshooting

Is the platen dirty?
Clean the platen by following the directions in this guide. If anything is stuck
to the platen, remove it, being careful not to damage the platen. The platen
often gets dirty at the same time as the head so it is recommended to clean
the platen as well as the head. If cleaning the head and the platen does not
work, contact the Fastback dealer from whom you purchased the printer.

7. Printing is not working or is extremely slow

Is the free space on the hard disk fragmented?
The time required for printing can increase dramatically if the free space on
the disk is extremely fragmented. Clean up your files and defragment the
disk by periodically using a defragment utility.

Is enough memory allocated?
Color printing may not be possible if the memory allocated to the applica-
tion is insufficient. Allocate more memory to the application.

Are you using memory management tools or virtual memory?
When you are using memory management tools such as RAM Doubler or
virtual memory, memory may not be correctly recognized for color printing.
When color printing is not working, disable these utilities and try again.

Do you have enough disk space?
Make sure there is enough empty space on your hard disk. (The working
space is released once printing is finished.) When there is just barely enough
working space left on the disk, printing may take much longer than normal.

Is the application set for color printing? Does the application support
color printing?
Some applications have color printing enable/disable settings. Some appli-
cations do not support color printing. Read the manual for the application
and check the color settings.

Are you using many applications at one time?
When very little memory is available for print processing, printing may take
a long time or fail. Close as many applications as possible and try again.

Do you have enough memory?
Handling color images requires a lot of memory for the application and for
the data. Sometimes there is insufficient memory left for printing. Make sure
your computer has enough memory to print the size of images you are
using.
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8. Sheet is not feeding correctly or not ejecting correctly
from the sheet feeder

Are you using a sheet that is folded or ripped?
The Foilfast printer is compatible only with specific types of cover materials.
Please see page 25, “Identifying Foil Cartridges and Cover Types,” for a list
of compatible cover types.

Are you using a curled sheet?

This will cause sheet jams. The sheet should be curled the opposite way to
flatten it out before it is used.

Are you using sheets with folded or cut corners?

This causes problems since the sheet position sensor and sheet length
sensor do not work properly.

Is there a sheet jam?
Clear the jam.

Is the paper feed guide too narrow for the sheet?
Set the feed guide so that there is approximately 0.02” between it and the
sheets themselves.

Are there too many sheets in the sheet feeder?
The sheet feeder can hold up to 10 composition covers or 1 ClearCover.

Is your cover too thick or too thin?

Composition covers should be between 16 —18.5 points thick (.0016 —
.00185 inches). Clear covers should be between 6.5 — 7.5 points thick (.0065
—.0075 inches). Covers that fall outside the bounds of these thickness ranges
may work in the Foilfast printer, but Powis Parker does not recommend
using them. Covers that fall substantially beyond these thickness ranges
may damage the printer's feeding mechanism and may void your warranty.

Is there anything blocking the output slot (such as a large pile of printed
sheets)?

This can cause ejection or feed problems.
Make sure nothing is on the output tray.

Have you loosened the sheets sufficiently prior to loading them into the sheet
feeder?
Sheets must fanned at least once before they are loaded into the sheet
feeder. If not, sheets may stick to one another, and cause multiple sheets to
feed into the printer at one time, or other forms of misfeed.

Is the error light blinking?
When the sheet is not fed (error light is blinking), press the ready/insert
button.
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If the sheet is not fed even by pressing the ready/insert button, the sheet
feed roller may be dirty. Clean the feed rollers by following the procedures
described below.

(1) Turn off the printer.

(2) The feed rollers are facing the cork pieces on the sheet feed tray, one on
the left, and two on the right as you face the front cover. Wipe the feed
rollers with a cotton swab dipped in water or with a soft wet rag.

Plate Cork pieces

(Feed rollers are across
from them)

(3) Press down the plate of the feed tray as you rotate the feed rollers. Wipe
each roller thoroughly. When the roller makes a turn, the plate of the
sheet feed tray may stay up. However, the plate will come down when
the printer is turned on.

9. Printer makes strange noises when the power is
turned on, and the error lights blink

Has the carriage packing material been removed?
Refer to Chapter 1 of this guide for detailed unpacking instructions.

Has the packing tape on the case been removed?
Refer to Chapter 1 of this guide for detailed unpacking instructions.

Has a cartridge become dislodged from a cartridge holder?
Open the front cover and make sure the ink cartridges are correctly in-
stalled.

Is there sheet caught between the platen and the print head?
See the section “Clearing sheet jams” and remove the sheet.

10. Mechanism or cartridge error

Are the cartridges correctly installed?
If a cartridge has become dislodged from the holder, a cartridge change
error will occur. Open the front cover and reinstall the cartridge.

Are you using the printer on a level surface?
The printer will not operate correctly on a slanted surface. Place it on a
level, stable surface.
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Is the printer in a place where it is subject to bumps or vibrations?
Bumps and vibrations can cause mechanical problems. Place the printer in
a place free from vibrations and bumping.

Is the front cover properly closed?

The printer will not operate correctly if the front cover is not closed properly.
Close the front cover all the way.

Is something sitting on top of the printer?
The printer may malfunction when there are things stacked on top or press-
ing it from the side. Do not place anything on top of the printer.

Is there an obstruction in front of the output slot?
If the output slot is obstructed, sheets ejected from the printer can fold and
bend and cause a malfunction. When printing, make sure that the paper
slot is unobstructed and that there is room for paper to be ejected.

Are you receiving erroneous “cartridge broken” messages?
Remove the cartridge and manually advance the foil, then reinsert the car-
tridge and try again. If the message recurs, try a different cartridge.

11. Cartridges are not correctly recognized

Is the bar code on the cartridge dirty?
Clean the bar code.

Is the cartridge installed in the holder with the (A) side up?
Make sure the cartridges are placed in the holder with B side up.

Has a cartridge for a different printer been installed?

Cartridges made by other manufacturers will not work. The Foilfast™ printer
will only accept Foilfast premium foil cartridges.

12 Printing Quality

There may be superfluous foil on the surface of the sheet after foil printing.
Gently wipe the superfluous foil with a Kleenex or soft cloth.

When using sheets with a rough texture, you may want to check Double
Pass Printing to increase the density of the foil. When Double Pass Printing
is checked, the printer prints each line twice. This check box is grayed out
when Foilfast ClearCovers is selected. In the Default setting, the Double
Pass printing checkbox is not checked.

Smoother sheets will give you a better print quality.

For printing on comp covers, try changing the Media Type setting from comp
cover HIGH to comp cover LOW, or vice versa.
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The Foilfast works best with Foilfast branded covers. Other covers may
work, but some may not be compatible.

13. Connection Method

Can | connect multiple printers to a single computer?

If different SCSI device numbers are used, multiple printers can be connected
to a single Macintosh. Of course, simultaneous printing is not possible.

Can | connect a single printer to multiple computers?
No, the printer is not designed for this.

14. Other problems and operations

Is this printer compatible with PostScript?
The Foilfast printer uses QuickDraw. It is not compatible with PostScript.

EPS files cannot be output clearly.
EPS files are data files for PostScript printers, and the Foilfast is not a
PostScript printer. Therefore, EPS files will print only as QuickDraw images
at 72 dpi.

Are enlargements and reductions possible?
Set either the enlargement or the reduction rate in the Reduce or Enlarge
setting in the Page Setup dialog box. This value may be specified between
25 and 400 percent.

The preview doesn’t change even though | change the reduction or en-
largement.
The preview will not change size with different reduction or enlargement
settings. Check the size after printing to see that the changes took effect.

How do | uninstall the printer driver?
Remove the Foilfast printer driver (“PPI Foilfast”) from the Extensions folder
in the System Folder, and remove the Foilfast Preferences file (“PPI Foilfast
preferences”) from the Preferences folder in the System Folder. If you have
installed the Queue Kit software, and you are not going to use it with other
applications, remove the Queue Monitor and Queue Watcher files from the
Extensions folder in the System Folder. Restart your computer.

Can this printer be connected to Windows and Macintosh computers si-
multaneously?
No, the parallel port and the SCSI port cannot be used at the same time.
Connect a Macintosh computer to the printer using the Macintosh interface
module, and connect a Windows computer without the module.
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Specifications

General Specifications

Name Foilfast™ Printer

Print head 240 dot

Printing speed 20 cps equivalent (When printing 10-cpi text)
Resolution 600 dpi

Printing area

7.43” x 12.93” maximum

Sheet feed method

Friction feed

Page width 3.85” minimum x 9” maximum
Page length 3.85” minimum x 14” maximum
Cover Types Foilfast™ Composition Cover

Foilfast™ Coated Paper Cover
Foilfast™ ClearCover™

Dimensions (inches)

Approximately 18.2" (width) x 11.8" (depth) x 7.5" (height)

Weight 11 Ibs. 8 oz. (5.2 kg)

Power supply 100-230 Vac 50/60Hz

Interface Parallel, SCSI (optional), USB (optional)
Head life 250 million pulses/dots

Machine life 10,000 sheets

Noise 51 dB Maximum

Agency approvals

UL, CUL, JET, CE, FCC Class B, VCCI

Operating environment

Temperature: 15°C to 30°C (50 to 86°F)
Humidity: 30% to 70% (without condensation or freezing)

Storage environment

Temperature: 5°C to 35°C (32 to 95°)
Humidity: 30% to 70% (without condensation or freezing)
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DIP Switches

DIP switches are used to set the SCSI ID number.

®® |on
o @ | OFF
12 3 4

The following summarizes the settings for each SCSI device number.

1 2 3 4 SCSI No.
OFF OFF OFF OFF No. 0
ON OFF OFF OFF No. 1
OFF ON OFF OFF No. 2
ON ON OFF OFF No. 3
OFF OFF ON OFF No. 4
ON OFF ON OFF No. 5
OFF ON ON OFF No. 6 —— (Factory default settings)
ON ON ON OFF No. 7*

* SCSI device number 7 is reserved for the Macintosh itself. Device number 0 is normally
assigned to the internal hard disk drive, if there is one. To be safe, use only device numbers

1 through 6.
Printable Area
A
0.47" minimum
Maximum
B Print area
0.6" minimum
C D

Maximum Print Area:

Physical Page Size Left Margin Right Margin
Page Size A B C D

Letter 8.5" 11" 0.47" 0.94"
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Available Supplies

Foilfast™ Supplies

Premium Foil Cartridges

Premium Gold Foil cartridge
Premium Silver Foil cartridge
Premium Red Foil cartridge
Premium Blue Foil cartridge
Premium Green Foil cartridge
Premium Black cartridge
Premium White cartridge
Primer cartridge (“Undercoat”)

Foilfast Compatible Covers

Foilfast Composition Cover
Foilfast Coated Paper Cover
Foilfast ClearCover™

Options

SCSiI Interface for Macintosh
USB Interface Kit for iMac and Windows 98

For complete document finishing, ask your dealer about Fastback document binding
and the PowisPrinter™. To locate the Fastback dealer nearest you, call Powis Parker at
1-800-321-BIND.
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